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INTRODUCTION 

WinSeis© is a software product developed at the Kansas Geological Survey to process seismic data for imaging 

seismic reflections. The first version of the software (known as Eavesdropper) was built in 1991 and has been 

improved over the years, turning it into a robust, reliable, and inexpensive software. The purpose of this WinSeis 1.8 

tutorial is to bring the original Eavesdropper tutorial up to date to account for the various improvements over the 

years and the way data are currently processed at the KGS.  

 

The tutorial update was applied in a fashion trying to preserve the original structure and content of the Eavesdropper 

Tutorial. 

 

Styles used in this document 

1. Folder paths are in a blue font,  

2. File names are highlighted in yellow, 

3. Menu and button clicks are shown in bold. 

INSTALLATION INSTRUCTIONS 

Programs and data contained on the demo CD will operate in a fashion nearly identical to the full WinSeis 1.8 

package. The demonstration software and manual have been compiled to instruct the novice as well as the seasoned 

processor. It is an opportunity to see and feel the flow of this seismic processing package. Only a small sampling 

of the operations available with the WinSeis package are included in this demo. 

 

Four types of data are contained in the installation folder and subfolders: 

 1) seismic data (extension = *.raw or *.dat), 

 2) sample batch files (extension = *.dek), 

 3) executable files (extension = *.exe. *.bat), and 

 4) assistance files (extension = *.ini, *.hlp, *.cfg, *.rd, *.ord, and*.clr). 

 

To minimize confusion, while processing the sample data it is advised to make a sub-folder containing the sample 

batch files, assistance file, and data files. This folder should be named something similar to “Tutorial.” 

 

Run the installation (e.g., “setup.exe” from the installation CD) and follow the instructions.  

 

If you obtained a 30-day free copy, a “RUS” window will appear after the installation with an “Apply Update” 

button. Click on it to apply the 30-day license. 

 

Double clicking on a *.dek file will automatically launch the WinSeis 1.8 processing engine, which will follow the 

command(s)/parameters and create a corresponding *.lst output file with processing information summary. 

CDP PROCESSING WITH WINSEIS 1.8 FOR THE NOVICE 

This document is designed to demonstrate the operation of WinSeis 1.8 by providing step-by-step detailed instruc-

tions and explanations of seismic data processing from raw data to brute stack. 

 

The format of the text in this document was specifically designed to aid in identifying 1) responses and information 

supplied to the user by the program upon request, 2) information or commands supplied to the program by the 

user, and 3) key points (highlights) to remember. The information supplied by the program will be in italics and 

includes error messages, file contents displayed on screen using the MS-DOS TYPE command, messages 

concerning information being processed, notes to the user concerning default parameters, etc. All italicized text in 

this manual indicates information generated by the program.  Information the user must supply to the program is 

always underlined and in bold type and includes execution commands, parameters to input, spaces necessary, etc.  
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Key information to remember is always in bold type.  After processing the sample data set completely through 

using this manual, future data sets could be processed by referring only to the bold-type information. The user 

should become quite comfortable with the material in this manual after processing the sample reflection data set. 

 

The WinSeis 1.8 seismic data-processing package is divided into three main categories: 

 1) Viewing and Plotting, 

 2) Graphical user interphase (GUI) routines for preparation of processing parameters modules  

 3) Seismic data processing (WSeis.exe) engine and additional modules. 

 

The viewing and plotting operations are interactive, requiring the user to execute the program and enter the 

requested information. The majority of the data processing procedures are contained within the sub-program file 

called “WSeis.exe”.  The program WSeis was designed to operate in a batch processing mode, requiring an input 

job file and an output list file. 

 

The input job file (.dek) contains all the operation commands/identifiers (*AUTS, *EDKL, *SORT, etc.) along 

with the appropriate user-assigned parameters.  The output list file (.lst) contains all the significant steps and pro-

cesses completed during the executed batch job.  The list file also contains bits of information concerning processing 

time, any abnormalities in the flow, any error messages, etc.  

 

A “.dek” file can be prepared by 1) using a simple text editor, such as Notepad.exe, which comes with the Windows 

operating system and 2) by using GUI routines available in the WinSeis 1.8 installation folder, such as 

“WinEdit.exe”, Winsort.exe, Winstat.exe, etc., which can help visually select the user-assigned parameters for each 

of the processes/commands. The latter are simultaneously written into a text file utility, “Command Editor”, 

(“Cmdedit.exe”) also available in the WinSeis 1.8 installation folder. 

 

There are three ways way to run/launch a “.dek” file: 

1. By using File Explorer (available with Windows 10, aka “Windows Explorer” in previous Windows ver-

sions) to find the necessary .dek file and just double click on it, which will be assumed by default hear after. 

2. Launch “WSeis.exe” from the “WSeis18” folder OR double click on the “WSeis.exe” desktop icon. Then 

select from the menu:  

File > Open > select “.dek” file > Open > Run 
3. The third (original) way to run a “.dek” file is by first launching the Command Prompt (i.e., “cmd.exe”, aka 

DOS Prompt). A shortcut to the Command Prompt can be found in the “Accessories” subfolder of 

Windows’ Start button. After navigating, then the user needs to type on the following: 

>WSEIS “name.dek” “name.lst”   <return> 

 

Operation of WinSeis 1.8 with the assistance of this manual requires a general knowledge of what seismic 

reflection is, as well as a working knowledge of a computer and the MS-DOS operating system (especially, if 

the third way of launching a .dek file is to be used). 

GENERAL CDP SEISMIC DATA PROCESSING FLOW 

The goal of digitally manipulating seismic data is to allow the maximum amount of geologic information to be 

extracted from a minimal amount of data and effort. The processing of seismic data involves a series of steps. Each 

seismic processing step generally has a prerequisite step or operation. This means a basic processing flow must be 

used to effectively process seismic data. The exact processing flow that should be used for a data set depends mainly 

on two things: 1) the overall quality of the data and 2) the particular information that will be extracted from the final 

processed section. 

 

The processing flow we use is structured to maximize shallow high frequency CDP seismic reflection data.  The 

general outline of our processing flow is contained in Table 2, which contains all the operations that are routinely 

used to go from raw field data to finished processed sections. This manual will discuss in some detail all the 

operations through brute stacking of seismic reflection data. The intention of this novice user’s manual is to get 
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a data processor started and somewhat familiar with the organization of the WinSeis software as well as some 

of the rationale for key parameter selections.  Each processor should establish a processing flow that is somewhat 

tailored to both the needs of the particular survey and to existing equipment. Some operations can be reordered/ 

removed/included/used several times and will either enhance, deteriorate, or not change the final section; however, 

some of the core operations (stacking, surface consistent statics, and normal moveout) do require prerequisite 

operations.  And all processing operations require proper formatting of the input data. 

 

Processing seismic data requires a basic understanding of acoustic-wave propagation through the earth (layered 

media). Attempting to process data without the necessary physics and math background will eventually result in 

frustration or non-results. To assist the novice/or out-of-practice seismic data processor, a sample data set is 

included with this manual. The data were collected May 1989 along the Thames River in England. Several good 

quality reflectors can be interpreted directly off the raw field files. The dataset will not present a significant 

challenge for the seasoned seismic data processor, but it will require a variety of standard processing steps properly 

applied to obtain a stacked section allowing the most realistic geologic interpretation. 

Introduction to Sample Data 

The raw data includes 20 field files chopped to a record length of 250 ms at a sample interval of 1/2 ms.  The data 

were acquired with an EG&G 2401 seismograph (processing 24 channels), single 100-Hz geophones, a 12-gauge 

buffalo gun (both the source and receiver intervals were 2.5 m), and 200 Hz analog low-cut filters.  The field notes 

are included within this manual. Each step in the general PROCESSING flow followed in this manual will use the 

England data set (DENGLAND.DAT) as the example.  Following in Table 1 are the KGS’s formatted data as well 

as 10 text *.dek files used to apply various types of processing. These files can be found in the “SampleData” sub-

folder of the application installation folder, e.g., “C:\WSeis18\SampleData”. 

 

PROCESS_J.DEK file applies nine processing steps in batch mode, providing single final-results output file. The 

rest of the .dek files apply only one type of processing. The .dek file name contains a number to indicate its sequence 

order/location in the all-inclusive PROCESS_J.DEK file. The output data file from each single-step processing is 

input data for the next step, i.e., the number in the .dek file name will increase by one. 

Table 1. Sample-data files 

DENGLAND.DAT 

EDKL_1J.DEK 

EDFM_2.DEK 

EDMT_3.DEK 

SORT_4.DEK 

SURF_5.DEK 

NMOT_6J.DEK 

FILT_7J.DEK 

SCAL_8.DEK 

STAK_9.DEK 

PROCESS_J.DEK 
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Table 2. Seismic reflection-data processing 

 
Table 2 concludes next page 
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Quick Processing Summary 

We recommend, for your convenience, you make a separate folder for experiencing the tutorial (e.g., a “WinSeis 

Tutorial” folder on one of your drives) and copy the contents of the “C:\WSeis18\SampleData” subfolder (i.e., the 

files listed in Table 1) into it.  

 

The digit in the above-mentioned file name indicates the processing order sequence in this tutorial. For example, 

the processing specified in EDKL_1J.DEK is applied first, in EDFM_2.DEK, second, etc. for all nine steps, the 

output of each being used as input to the next step (see Table 3). The file PROCESS_J.DEK applies all nine steps 

providing only one final output file, stakAll.dat. Separate GUI applications can facilitate the preparation of the 

*.dek files (last column of Table 3). 

Table 3. Processing steps with corresponding input/output data 

Processing 

Sequence 

Processing-command 

*.dek file 

 

Input data file 

 

Output data file 

 

*.dek-file maker GUI  

1 EDKL_1J.DEK DENGLAND.DAT EDKL.dat WinEdit.exe 

2 EDFM_2.DEK EDKL.dat EDFM.dat WinEdit.exe 

3 EDMT_3.DEK EDFM.dat EDMT.dat WinEdit.exe 

4 SORT_4.DEK EDMT.dat SORT.dat Winsort.exe 

5 SURF_5.DEK SORT.dat SURF.dat Winstat.exe 

6 NMOT_6J.DEK SURF.dat NMOT.dat Winvscn.exe 

7 FILT_7J.DEK NMOT.dat FILT.dat Winfilt.exe 

8 SCAL_8.DEK FILT.dat SCAL.dat  

9 STAK_9.DEK SCAL.dat STAK.dat  

     

1-9 PROCESS_J.DEK DENGLAND.DAT stakAll.dat  

 

Double click on each of the *.DEK files in Table 3 following the processing sequence folder so that the output file 

from each is available as an input file for the next. Finally, double click on the PROCESS_J.DEK file to run all 

processing steps in one flow, providing a single output file, stakAll.dat, identical to the STAK.dat from last step 9. 

TRACE HEADERS 

For a more in-depth discussion on header/format for WinSeis please refer to the Winseis Turbo User’s Manual, 

Section 1.1 (KGS Format, Trace Headers, Trace Header Change, and Check Data). 

 

IMPORTANT: All acquisition information essential to future seismic data processing as well as update informa-

tion derived from intermediate processing operations is organized and stored within each trace header. The 

organization of trace headers is dependent on the programmer of the software and manufacturer of the seismograph.  

The size and organization of the trace header, its location, as well as the organization and size of each sample 

of data within the trace itself is commonly referred to as seismic data format. The format of seismic data is 

critical to the effective operation of seismic data processing programs.  Each format is different, requiring a different 

approach. 

 

Most, but not all, operations use the header to obtain key information about the data contained within each trace.  

Some operations will update the header with information; others will simply use the information to physically 

change the data set according to the prescribed operation and designated parameters. The trace header locations will 

always remain the same. The actual values within each word in the header can or will be changed in accordance 

with the described operation and input parameters. 

 

Familiar acronyms such as SEGA, SEGB, SEGY, modified-SEGY, SEG2, etc., describe individual variations in 

data format. 
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The key information necessary to process seismic data using WinSeis 1.8 is contained within the 240-byte trace 

header (120 16-bit words) preceding the seismic data itself, which is represented by 2 bytes per sample word (i.e., 

500 sample/trace data represent a block of 1000 bytes). Each header location is identified by a number (1-120).  

WinSeis 1.8 expects to see a header at the beginning of each trace (240 bytes) followed by a data block (length 

dependent on number of samples).  The header contains the information at the designated word locations shown in 

Table 4 below. 

DATA FORMAT 

Raw unformatted data on the hard disk (HDD) will be in the form of a sequence of files with identical prefixes 

and/or extensions, where each file represents a unique field file recorded on the seismograph used and downloaded 

onto a computer’s hard disk. The naming process was done during either the downloading of the data to a computer’s 

hard disk or at the time of acquisition and storage of the data in the field. The total number of these individual 

sequential files will be equal to the number of field files copied onto the hard disk. Once the data are on the hard 

disk of the computer (in most cases this involves a simple copy command), the appropriate conversion routine 

should be executed to correctly format the data for future processing with WinSeis 1.8 software.  After completing 

the formatting operation, all the individual field files should be contained in a single MS-DOS file. 
 

Table 4—Trace-header descriptions. WinSeis 1.8 

        All words in the header are 16-bit words; ms = milliseconds.  Feb 2015 
 

Word# Description 

 1 Data type: 

   0 = raw field 

   1 = CDP gather 

   2 = CDP stacked 

   3 = record order (record-number index and trace-number index based on values in  

trace-header words 3 and 4, respectively) 

   4 = velocity-scan data 

 2 Total recording channels 

 3 Trace-header word of record number for this data set:  

   8 = common recording channel number 

   12 = common depth point 

   19 = common offset 

   86 = common receiver station number 

   87 = common source station number 

   92 = common source sequence number 

 4 Trace-header word of trace number within each record    

(0 = input order of seismic input data to be sorted) 

 5 Trace-direction flag for sorted traces within each record:  

1 = ascending 

   -1 = descending 

 6 Original field-record number 

 8 Recording-channel number 

 10 Repeated shot number (at the same station) 

 11 Time/depth flag and multiplication factor (about 1000) to fit word 57 into 16 bits:  

   0 = time 

   1 or more = depth 

 12 CDP number 

 14 Trace number within each record 

 15 Trace-identification code: 

   1 = seismic data 

   2 = dead 

9 = velocity flag 
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 16 Number of vertically summed traces yielding this trace 

 17 Number of horizontally summed traces yielding this trace 

 18 Feet/meter distance dimension flag: 

   0 = feet 

   1 = meters 

 19 Offset (distance from source to receiver) after multiplication by word 35 

 21** Receiver-group elevation 

 23** Source elevation 

 27** Datum elevation 

 35 Multiplication factor for horizontal distance 

 36-38 SEG-2 X, Y, Z receiver locations 

 39-41 SEG-2 X, Y, Z source locations 

 48 Measured first arrivals (milliseconds) 

 49 Measured first arrivals, the microseconds component only (<1 ms) 

 50* Source static correction (milliseconds) 

 51* Receiver-group static correction (milliseconds) 

 52* Total static correction (in number of samples) that has been applied to this trace (zero if no static has 

been applied)  

 53 Calculated first arrivals (milliseconds) 

 54 Calculated first arrivals, the microseconds component only (<1 ms) 

 55 Recording-delay time (milliseconds) 

 57 Distance sample interval (in m or ft) [the true value was multiplied by word 11 to fit a 16-bit word] 

 58 Number samples in this trace 

 59 Sample interval in microseconds for this trace 

 60 Integer/floating point data flag: 

   21930 = floating point 

   any other value indicates integer data 

 70 Analog low-cut frequency (Hz) 

 71 Analog high-cut frequency (Hz) 

 75 Applied digital low-cut frequency (Hz) 

 76 Applied digital high-cut frequency (Hz) 

 82 Minimum receiver-station number 

 83 Maximum receiver-station number 

 84 Minimum source-sequence number 

 85 Maximum source-sequence number 

 86 Receiver-station number for this trace 

 87 Source-station number for this trace 

 88 Last trace flag: 

   0 = not last trace 

   1 = last trace of this gather 

 89* Surface-consistent residual-receiver static (in number of samples) that has been applied to this trace 

 90* Surface-consistent residual-source static (in number of samples) that has been applied to this trace 

 92 Source-sequence number (SSN) 

 93 Processing-history file flag: 

   0 = no history 

   non-zero = number of characters in file name that follows 

 94-120 Reserved for processing-history file name; packed ASCII, two ASCII characters per word 
 

*Convention for static corrections:  POSITIVE value implies static shift (DOWN) away from zero-time, NEGATIVE value 

implies static shift (UP) toward zero-time. 

**Elevation can be either absolute (i.e., positively above sea level) or relative (with reference to fixed altitude).  In both 

cases, the orientation is such that higher elevation is positive.  Therefore, increasing depth is indicated by the smaller 

value for elevation.     
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Formatting of seismic-reflection data involves organizing trace headers and data bytes into a specific pattern 

and sequence recognizable by Winseis 1.8. The formatting utilities available for Winseis 1.8 require raw unfor-

matted data to be present on hard disk.  The formatting utilities (conversion routines) are designed to operate on 

raw data input from hard disk and output back to hard disk.  Getting the raw data from the seismograph’s preferred 

storage media onto the hard disk requires procedures, software, and/or hardware that can be supplied by the 

seismograph manufacturer. 

 

The particular formatting routine necessary for any raw unformatted data depends on the seismograph with which 

it was collected.  Until a standardized format can be established and agreed upon by all seismograph manufacturers 

and software developers, a different conversion routine will be necessary for most new and existing seismographs. 

DISPLAY 

After the data are in KGS format, examination of a variable-area wiggle-trace display of all the unprocessed data 

will allow the user to verify proper formatting as well as to get a general feel for the quality and quantity of data. 

 

It is possible to display records and sections by using the “Winview.exe” tool, which can be found in the WinSeis 

1.8 installation folder (e.g., “WSeis18” ). The following the file path will guide the user through the display module:  

double click on “Winview.exe”. Then select from the menu: File > Open > Select .dat file > Open.  Visual graphics 

can be altered by selecting graphics from the Options tab.  Here the user may change the parameters to adjust 

viewing preferences (Figure 1). 
 

 

Figure 1. Winview.exe main menu. 

 

Once the .dat file is open and displayed (Figure 2), select Options (from the drop down menu), followed by Change 

Graphics.  A “View Select” window will be displayed (Figure 3), which will allow the user to specify the viewing 

parameters they wish.  Once all the parameters have been specified to the user’s preference, click on the “Done” 

button and the settings will be applied  

 

The raw England field data (dengland.dat) should contain 20 files identified by the source sequence number in the 

upper righthand corner of each file. The data were collected on a 24-channel seismograph, therefore, there will be 

24 individual traces within each field file. The traces within each field file are identified by original channel num-

bers, starting with channel 1 on the left-hand side of the field file, and channel 24 on the far right. 

 

The field file displayed here has all the major types of seismic energy arrivals one will encounter on most seismic 

data sets (Figure 4). Identified on the plot of field file 5 is each trace number, time in milliseconds, refraction energy, 

air-coupled waves, ground roll, and of course reflection events. Of interest for later processing steps, two dead 

traces are identified at trace numbers 8 and 23. The field file displayed has been scaled to enhance the seismic 

energy, making it easier to identify the various types of arrivals. 
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Figure 2. Field-file 1 graphical display using WinView.exe. 

 

 

Figure 3. WinView, "View Select" window for display parameters. 
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Figure 4. Traces 8 and 23 of the displayed source sequence file 5 are bad traces. 

EDIT TRACES 

The next step in a standard processing flow involves the removal of bad traces (generally caused by dead 

geophones, bad geophone plants, seismograph amplifier failure, cultural noise, or poor near-surface conditions), 

bad parts of traces (generally resulting from air-coupled wave or ground roll), and energy arriving prior to the 

first identifiable reflection signal (generally refraction and direct-wave energy). 

Manual Bad-Trace Edit 

Removal of dead or bad traces is the first editing step.  This can be accomplished in two different ways.  The first 

way (the more standard technique) involves the manual entering of each trace (to be removed) into a text-editor-

built edit deck using the *EDKL procedure.  The second way uses an automatic whole-trace-editing routine *AUED 

procedure designed to identify (and automatically remove, if specified) any trace that does not meet the minimum 

operator-specified signal-to-noise ratio (S/N).  In order to develop a good working knowledge of the editing process 

and how it works, it is recommended that command of the manual editing technique be established prior to extensive 

use of the automatic editing option. 

© Kan
sa

s G
eo

log
ica

l S
urv

ey
  ©

 Kan
sa

s G
eo

log
ica

l S
urv

ey
  ©

 Kan
sa

s G
eo

log
ica

l S
urv

ey
 

 
 

 
 

 
© Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey

 

 
 

 
 

 
© Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey

 

 
 

 
 

 
© Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey

 

 
 

 
 

 
© Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey

 

 
 

 
 

 
© Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey



2020-08-13  

 WinSeis 1.8 — 2020 Tutorial 16 of 71 

 

Note: For ultimate control over the data quality, using the *EDKL function is preferable. 

 

A plot of the raw-field data is critical at this step.  Careful examination of each trace of every field file will allow 

the user to determine how much and what type of editing will be necessary.  The object of this stage is to remove 

all traces and parts of traces with an unacceptable signal-to-noise ratio (S/N).  Determination of useless traces is 

subjective and depends on the ability of the user.  Traces 8 and 23 of the displayed source sequence file 5 (Figure 

4) are bad traces.  It is important to remember (all things being equal) that 2 or 3 fold of high-quality reflection 

data are better than 48 fold of poor data. The confidence necessary to effectively edit will come with time and 

exposure to a variety of data sets. 

 

The manual editing procedure is a batch-processing operation and therefore requires a batch-processing file con-

structed around the *EDKL identification. In order to build a batch-processing file the user can employ a TEXT 

EDITOR. NOTE: Any text editor that does not leave embedded commands will work (e.g., EDLIN, 

SIDEKICK NOTEPAD, XTREE, etc.).  Furthermore, for large data sets, Microsoft Excel can be used to organize 

information that is then copied and pasted into a text document.  Using “Save As”, save the text file with extension 

“.dek” to allow “WSeis.exe” to run the commands. Another way to build a “.dek” file is by using GUI routines 

available in the WinSeis installation folder, such as “WinEdit.exe”, which can help visually . 

 

This is the first batch processing deck described in this manual; therefore, each part will be discussed in some detail 

and referred to during upcoming processes. 

 

Line Description 

 

1 >>START 

 

 >>START simply identifies the beginning of this processing deck. 

 

2 *INPF dengland.dat 

It is necessary to include the whole file path for WSEIS to properly work, (e.g., C:\Tutorial\dengland.dat).  

All input and output files require the full file path.  Since all file paths are different, they will not be included 

in the descriptions here. 

 

*INPF command identifies the input files.  The alpha character name of the input file, including any exten-

sion must follow *INPF, leaving at least one space separating the F in *INPF and the first character of the 

file name. 

 

Entries following an alpha identifier (such as *INPF, *EDKL, *AUTS) need only be separated by a 

minimum of one space.  This means that during batch processing, any input information need only be 

in the correct relative sequence.  The program “WSeis.exe” is insensitive to absolute field location and 

lower or upper case (i.e., A or a). 

 

3 *EDKL 92 8 

 

EDKL calls the “kill trace” sub-routine.  The traces to be removed are identified by a record-number 

trace-number pair [92 (SSN), 8 (field trace number)].  As the processor becomes more efficient and 

knowledgeable, other sorting options are possible (e.g. 87, 86, etc.). 

 

Record numbers generally identify the primary grouping order. In case of raw field data, the primary 

grouping is by field-file number, which is contained in trace-header location 6; for CDP gathers, the 

primary grouping is according to CDP number, which is contained in trace-header location 12.  Trace 

numbers generally identify secondary grouping order.  In the case of raw field files, the secondary grouping 
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is according to seismograph channel numbers, which are contained in trace-header word 8.  This grouping 

or ordering can be changed during the sorting or resorting operation. 

 

These record/trace pairs can be thought of in a similar fashion to a deck of cards; that is, the suite (hearts, 

clubs, spades, diamonds) can be thought of as the record number and the value (Queen, Jack, ten, nine, etc.) 

can be compared to the trace number, such that any trace can be identified by record number and trace 

number in the same fashion any playing card can be identified by suite and value. 

 

The program allows the user to select any trace-header word to be the record number portion as well as any 

trace header word for the trace number portion of the record-trace pair. In this case, we have designated the 

Source Sequence Number (SSN) (assigned during formatting), header word 92, as the record number 

portion and the trace numbers within each field record, header word 8 (which is the seismograph’s actual 

channel number), as  the trace number (assigned by seismograph during acquisition). 

 

4 KILL 1 1 12 12 

 

KILL is a command operation that identifies which trace(s) within the specified records are to be 

removed.  In the above case, trace 12 record number 1, will be removed. 

 

5 KILL 2 2 11 11 

KILL 3 3 10 10 
KILL 4 4 9 9 24 24    (i.e., Traces 9 and 24 of record 4 will be removed.) 

KILL 5 5 8 8 23 23 

KILL 6 6 7 7 22 22 

KILL 7 7 6 6 21 21 

KILL 8 8 5 5 20 20 

KILL 9 9 4 4 19 19 

KILL 10 10 3 3 18 18 

KILL 11 11 2 2 17 17 

KILL 12 12 1 1 16 16 

KILL 13 13 15 15 

KILL 14 14 14 14 

KILL 15 15 13 13 

KILL 16 16 12 12 

KILL 17 17 11 11 

KILL 18 18 10 10 

KILL 19 19 9 9 

KILL 20 20 9 9 
 

6 *OUTF EDKL.dat 

 

*OUTF identifies the destination file name of the edited data. The file name can be any MS-DOS acceptable 

name, with or without extension. The output file name can be the same as the input.  Of course, if the input 

file name is the output file name, the input data will be deleted and replaced with the edited output data. 

 

7 >>END 

 

>>END identifies the last line of this batch-processing deck. 

 

The actual bad trace edit file just created will look like this: 

 

>>start 

*inpf dengland.dat 

*edkl 92 8 
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kill 1 1 12 12 

kill 2 2 11 11 

kill 3 3 10 10 

kill 4 4 9 9 24 24 

kill 5 5 8 8 23 23 

kill 6 6 7 7 22 22 

kill 7 7 6 6 21 21 

kill 8 8 5 5 20 20 

kill 9 9 4 4 19 19 

kill 10 10 3 3 18 18 

kill 11 11 2 2 17 17 

kill 12 12 1 1 16 16 

kill 13 13  15 15 

kill 14 14  14 14 

kill 15 15 13 13 

kill 16 16 12 12 

kill 17 17 11 11 

kill 18 18 10 10 

kill 19 19 9 9 

kill 20 20 9 9 

*outf edkl.dat 

>>end 

 

 Use the “WinEdit.exe” GUI and choose Edit>Edit Options>EDKL-Kill Trace from the main menu to 

visually select bad traces to be killed. Each mouse-click selection on the seismic-data image will be simul-

taneously written into the text file utility, “Cmdedit.exe”. See WinSeis User’s Manual (i.e., pages 1-13 and 

1-14 of “4section1.pdf”). 

 

The batch processing file above to edit bad traces now needs to be run through “WSeis.exe” to operate on the 

dengland.dat. 

 

Double click on the EDKL.dek file to launch “WSeis.exe” and run the .dek file. 

 

The edited data will be in the file named EDKL.dat. The now worked-on data can be viewed using “WinView.exe”, 

which can be found in the main application folder (e.g., “C:\WSeis18”). Once the bad-trace editing is complete, 

each field file should be missing the trace or traces the user has selected to remove (Figure 5).  The trace is not 

displayed on the plot because the dead-trace flag (trace header word 15) has been tripped in the trace header. The 

file size will not change until the data are sorted or resorted, at which time the trace will be completely removed 

from the data set. The bad trace is still present in the data file after trace editing, but not visible on the plot. 

 

AT THIS POINT, IF YOU HAVE MANUALLY EDITED ALL YOUR BAD TRACES, YOU SHOULD 

PROCEED TO THE FIRST-ARRIVAL MUTING PORTION OF THIS MANUAL WHICH FOLLOWS 

AUTOMATIC EDITING (*AUED). IF TIME PERMITS, USE YOUR JUST-EDITED DATA SET TO COM-

PARE AUTOMATIC EDITING TO MANUAL BAD-TRACE EDITING. IT MAY SERVE TO HELP YOUR 

CONFIDENCE AS WELL AS SAVE YOU TIME DURING PRELIMINARY BAD-TRACE EDITING ON 

YOUR NEXT DATA SET. 

Automatic Bad-Trace Edit 

Using the automatic editing routine (*AUED) will save time in removing obviously dead or traces of very poor 

quality.  It should only be used, however, once you are comfortable with the manual trace editor (*EDKL).  The 

*AUED routine is mainly designed to remove traces that are totally dead or possess a significant amount of back-

ground noise (i.e., wind, powerline, automobile, human traffic on-line, etc.). The important parameters in this 
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operation are the noise window length (time) and the acceptable signal-to-noise ratio (S/N) value. At this point, 

definitions will be helpful. 

NOISE WINDOW 

The noise window identifies a pre-first-break segment (before the arrival of any seismic signal) on each trace 

where the level of background ambient noise is representative of the remainder of the trace.  The window needs 

to be selected so as to not include any source-generated seismic signal (such as refractions, direct wave, or air 

wave). 

SIGNAL-TO-NOISE (S/N) 

The signal-to-noise value is the ratio of the whole trace average amplitude and the average amplitude of signal in 

the noise window.  An S/N value of 1 will retain any trace with a whole trace average amplitude equal to or greater 

than the average amplitude of the signal in the noise window. 

 

Experimentation with this routine is the best teacher. A few test runs varying the S/N value for a given noise window 

will give insight into both the utility and the limitations of this routine. A batch-processing file for doing automatic 

editing should look something like this: 

 

Line Description 

 

1 >>START See *EDKL for details on >>START. 

 

2 *INPF dengland.dat See *EDKL for details on *INPF. 

 

3 *AUED 20 0.28 1 1 1 

 

*AUED calls the auto-edit sub-routine. The first requested parameter is the noise window. Here 20 ms 

is used, indicating that no source-generated signal arrives on any trace before 20 ms. The second requested 

parameter is the signal-to-noise ratio (S/N) value. A signal-to-noise ratio of 0.28 means any trace not 

possessing an average whole-trace amplitude at least 0.28 times the average pre-first-break amplitude 

will be flagged.  The third requested parameter instructs the program to print (1) or not to print (0) the 

calculated average whole trace signal-to-noise ratios (S/N) in the list file. The fourth requested 

parameter instructs the program to print (1) or not to print (0) the flagged bad traces in the list file.  

(This fourth option gives the user the opportunity to examine the traces the program suspects as being 

bad.)  The fifth and final option lets the user delete the flagged bad traces (1) or save all the traces as 

inputted (0). Keeping the flagged bad traces will allow examination of the suggested bad traces and 

readjustment of parameter 1 (noise window) and 2 (signal-to-noise ratio), or both.  If the 0 option is chosen 

for the fifth parameter, no output file need be named. 

 

4 *OUTF AUED.dat See *EDKL for details on *OUTF. 

 

5 >>END See *EDKL for details on >>END. 
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Figure 5. Bad traces have been removed. 

 

The batch-processing file AUED.dek the user just saved will look like this: 

 

>>start 

*inpf dengland.dat 

*aued 20 0.28 1 1 1 

*outf aued.dat 

>>end 

 

Double click on the AUED.dek file to launch “WSeis.exe” and run the .dek file. 

 

The AUED.lst file monitors and records the sequence of processing events. 

 

The following information is included to allow the user to check the contents of the list file with what should be 

there: 
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List of example of signal-to-noise ratio of SSN 4: 

 

4: 3.24 2.43 3.39 3.10 5.60 3.26 0.62 1.45 0.23 1.42 0.81 1.47 

 0.32 0.94 0.44 0.92 2.45 1.26 1.42 0.64 2.11 1.14 0.71 0.21 

 

List of bad traces for SSN 4 from automated editing: 

 

4: 9 24 

 

The edited data will be in the file named AUED.dat.  To see the effect of the editing on the raw data, the user should 

first use the “Winview.exe” by selecting AUED.dat to view the plot. 

First-Arrival Mute 

The next step in the processing flow involves the muting of refracted and direct-wave energy (*EDFM).  This 

is necessary on most data sets to ensure that refracted and/or direct-wave energy does not appear coherent on CDP 

stacked sections.  The high amplitude as well as the coherent nature of moved-out and stacked refraction energy is 

inviting, and in some situations it can be easily misinterpreted as shallow-reflection energy. 
 

Complete identification of refracted energy is sometimes difficult on CDP stacked data. Refraction energy has 

theoretically linear moveout on field files.  The NMO velocity correction applied to compensate for non-vertically 

incident reflection energy is hyperbolic.  When refraction wavelets—generally non-minimum phase and rarely 

broadband—are NMO corrected and stacked, they can misalign in such a way as to appear as multiple, broadband, 

coherent reflection events very dissimilar from the original refraction wavelets on the raw field data. The 

appearance of refraction energy on CDP-stacked data can be wrongfully identified and must be scrutinized 

carefully.  Unmuted refracted energy from a subsurface layer that varies in depth can appear to be a structurally 

significant, coherent reflection event on CDP stacked data.  This illusion on stacked data results from the changes 

in the critical refraction distance and time intercept as the depth to the refracting interface varies.  This pitfall may 

go unnoticed on some data sets, since in some geologic conditions stacked refractions may be representative, in a 

gross sense, of actual shallow structure.  Such stacked refractions typically have lower frequency than shallow 

reflections. 

 

Any editing operation that requires the defining of a time window or beginning and/or ending points for the zeroing 

of data will require the defining of a taper length (TAPR).  The taper is intended to allow the gradual attenuation 

of the trace amplitudes to zero without generating an abrupt truncation point and the associated apparent high 

frequencies.  If the trace is filtered at any time in the processing flow without a taper, the abrupt truncation 

of signal resulting from a mute will produce a complex sine function with maximum amplitude at the 

truncation point decaying to near zero within the muted zone.  The frequency and decay length of the sinusoid 

is dependent on the defined filter. This decaying sinusoid is an artifact of the Fast Fourier Transformation (FFT), 

which is part of the spectral filtering process. Frequency filtering is often necessary to remove or attenuate unwanted 

noise.  Choosing a taper length is a very data-dependent undertaking. At least one cycle of the dominant-reflection 

frequency or center frequency of the digital bandpass filter designed for this data set is a good starting point 

for defining a taper length.  Fine tuning of a mute taper generally is not necessary, but in certain instances returning 

to this step in the processing flow to better define a taper length may be necessary. During future processing 

operations involving a taper, reference to this paragraph will be made.  In this manual, the taper is defined according 

to Figure 6. 

 

The first step in the first-arrival muting process is to identify refracted and direct-wave energy on the raw field 

plots (Figure 4).  Once a definite identification is made, the appropriate mute can be designed.  Once the mute 

window for each field file has been determined, a batch processing sequence similar to the following should be 

created. 
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Figure 6. Definition of the taper as applies to this manual. 

Line Description 

 

1 >>START See *EDKL for description of >>START. 

 

2 *INPF EDKL.dat See *EDKL for description of *INPF. 

 

3 *EDFM 92 8 

 

The *EDFM identifier calls the first-arrival mute subroutine.  The two requested parameters are trace-

header words that identify the record/trace pairs (as described during the *EDKL routine).  The first 

requested parameter identifies the primary groups or records (in this case the SSN’s trace-header location 

92 identifies the record portion of the record-trace pair).  The second requested parameter is the trace-

header word that identifies the location of secondary groups or traces within the record (in this case the 

channel numbers of the seismograph, trace-header location 8, identifies the trace portion of the record-trace 

pair). 

 

4 TAPR 10 

 

TAPR sets the taper length, which is in ms (milliseconds).  The taper slope is linear and is designed 

to allow a gradual transition from unaffected data to 100 percent mute.  The taper’s 0 percent point (total 

attenuation) is at the user-defined first-arrival mute value and the 100 percent point (no attenuation) is at 

the defined mute time plus the taper length.  In this case, if the first-arrival mute extended to 30 ms on 

trace 1, the taper would attenuate 90 percent of the signal at 31 ms, 80 percent of the signal at 32 ms, 70 

percent of the signal at 33 ms, etc., until at 39 ms 10 percent of the signal was attenuated. 

 

 5a FARM 1 1 30 2 32 3 33 4 35 5 36 6 38 7 39 8 41 9 42 10 44 11 45 12 47 13 48 14 50 15 51 16 53 17 54 

18 56 19 57 20 59 21 60 22 62 23 63 24 65 
 

FARM defines first arrival mute times according to SSN and trace number.  The FARM operation is 

designed to interpolate both in time and space. This interpolation process makes the entry on line 5b the 
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same as the entry on line 5a.  If only line 5a or 5b FARM was defined, the entire data set would be first-

arrival muted according to the defined record number-time windows.  The actual mute defined by line 5a 

or 5b would include the entire data set and delete all data between time zero and 30 ms on trace 1, from 

time zero to 32 ms on trace 2, from time zero to 33 ms on trace 3, etc., out to trace 24 which will be muted 

from time zero to 65 ms.  If more than 24 traces are present in this data set, each trace beyond trace 24 will 

be muted as trace 24 was.  This means that trace 25 will be muted from time zero to 65 ms, trace 26 will be 

muted from time zero to 65 ms, trace 27 will be muted from time zero to 65 ms, etc. 

 

5b   FARM 1 1 30 24 65 

 

 This defines exactly the same first-arrival mute as line 5a. 

 

† 6a FARM 2 1 0 24 0 
 

† 6b FARM 3 1 30 24 65 
 

† 6c FARM 4 1 0 24 0 
 

† 6d  FARM 3 1 30 24 65 25 0 
 
† Note: Not appropriate for this data set—used here only as an example. 

 

If only one file of several is to be first-arrival muted (FARM), the series of entries on lines 6a, 6b, and 

6c would be necessary. The linear interpolation process is automatic. The only way to stop the interpola-

tion is to define 0 mute times just before and just after the defined mutes.  The FARM defined by lines 6a, 

6b, and 6c will mute file (SSN) 3 only, with trace 1 muted from time zero to 30 ms, trace 2 from time zero 

to 32 ms, etc., out to trace 24, which will be muted from time zero to 45 ms.  To stop the mute process 

after trace 24, therefore retaining all the information in traces 25 to the last trace (48, 96, or whatever the 

number of traces on the seismograph the data came from), line 6d would be entered in place of line 6b. 

 

7 *OUTF EDFM.dat See *EDKL for description of *OUTF. 

 

8 >>END See *EDKL for description of >>END. 

 

The EDFM.dek text file will contain: 

 

>>start 

*inpf  edkl.dat 

*edfm 92 8 

tapr 10 

farm 1 1 30 24 65 

*outf edfm.dat 

>>end 

 

 Use the “WinEdit.exe” GUI and choose Edit > Edit Options > EDFM-First Arrival from the main menu 

to visually select zeroing top parts of traces. Each mouse-click selection on the seismic-data image will be 

simultaneously written into the text file utility, “Cmdedit.exe”. See WinSeis User’s Manual (i.e., pages 1-

13 and 1-14 of “4section1.pdf”) 

 

Double click on the EDFM.dek file to launch “WSeis.exe” and run the .dek file. 

 

As before, EDFM.lst is simply a journal file.  The muted data will be in the file named EDFM.dat.  In order to see 

the effect of the mute on the input data EDKL.dat, the user needs to use the WinView.exe module.  The first-
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arrival mute defined by the previous batch file will result in a mute on all files of the sample data set.  First-arrival 

information on file 5 will begin at 30 ms on trace 1 and 65 ms on trace 24 with a 10 ms taper. This field file is 

displayed identically before and after the mute allowing direct comparison (Figure 7).  

 

 

Figure 7. Field file 5 a) before and b) after first-arrival mute. 
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Surgical Mute 

The final editing step involves the surgical removal of bad trace segments (*EDMT). Noise resulting from the air-

coupled wave, electronic interference other than power line frequencies, and ground roll are generally constrained 

to isolated portions of a trace.  High-amplitude noise obviously dominating a well-defined time window should be 

removed.  However, take care when removing these low S/N portions of traces because significant seismic signal 

could be present on unprocessed data at an amplitude level below the dynamic range of the plot.  This indicates that 

it could go unnoticed.  If the amplitude of the unwanted noise is low in comparison to signal at equivalent times on 

other traces, occasionally the multi-trace stacking process necessary to generate a CDP stacked section will suppress 

noise to an acceptable level. 

 

Also, many times various filtering operations (discussed later in the processing flow) can attenuate noise that has 

unique spectral and/or phase characteristics.  It must be kept in mind that removal of noise and enhancement of 

seismic signal to allow an accurate geologic interpretation is the ultimate goal.  There is no replacement for good 

judgment during the preliminary stages of seismic data process. 

 

The plot of the first-arrival muted data needs to be carefully studied and appropriate time and trace pairs selected 

to remove the air-coupled wave.  Once the desired mute windows on the data have been defined and the trace time 

pairs recorded, the mute batch file needs to be created.  The following sequence of entries is appropriate for our 

sample data set. 

 

Line Description 

 

1 >>START See *EDKL for description of >>START 

 

2 *INPF EDFM.dat See *EDKL for description of *INPF 

 

3 *EDMT 92 8 

 

The *EDMT identifier calls the surgical muting subroutine.  The two requested parameters are the trace-

header words that identify the record-trace pairs (as described in the *EDKL and *EDFM routines).  The 

first requested parameter is the trace-header word identifying the primary groups or records (in this case 

the SSN [trace-header location 92] identifies the record portion of the record-trace pair). The second 

requested parameter is the trace-header word that identifies the secondary group or trace location within 

the record (in this case the channel number of the seismograph [trace-header location 8] identifies the trace 

portion of the record-trace pair). 

 

4 TAPR 10 

 

TAPR sets the taper length as described in Figure 6.  The units of taper length are ms (milliseconds).  The 

taper slope is linear and is designed to allow a gradual transition from unaffected data to 100 percent 

mute.  The taper’s 100 percent point (total attenuation) is at the user-defined first-arrival mute value and 

the 0 percent point (no attenuation) is at the defined mute time plus (or minus, depending on which end of 

the mute zone) the taper length.  In the case of a 10 ms taper on a mute window starting at 57 ms and 

ending at 70 ms, the data would experience 0 percent signal attenuation at 47 ms increasing linearly to 

100 percent attenuation at 57 ms (with 100 percent attenuation between 57 and 70 ms) and the attenuation 

would then decrease linearly from 100 percent at 70 ms to 0 percent at 80 ms. 

 

 5a MUTE 5 1 57 70 24 222 235 (preferred option and technically identical to line 5b). 

 

5b MUTE 5 1 57 70 2 64 77 3 71 84 4 78 91 5 86 99 6 93 106 7 100 113 8 107 120 9 114 

 127 10 122 135 11 129 142 12 136 149 13 143 156 14 150 158 171 16 165 178 17 172 

 185 18 179 192 19 186 199 20 193 207 21 200 214 22 207 221 23 214 228 24 222 235 
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The MUTE identifiers on lines 5a and 5b define a surgical mute for the entire data set.  The program 

will linearly interpolate between all defined windows throughout the entire data set.  The interpolation 

process is automatic and can only be terminated by entering zeros (beginning and ending) within the 

time ranges.  For the mute defined on lines 5a and 5b, the entire data set will be muted with all trace 1’s 

zeroed (all digital information removed and replaced by zeros) between 57 and 70 ms, all trace 2’s zeroed 

between 64 and 77 ms, all trace 3’s zeroed between 71 and 84 ms, etc., out to all trace 24’s zeroed between 

222 and 235 ms.  If more traces are present on the records, they will be muted according to the trace 24 

defined mute (i.e., all trace 25’s will be muted between 222 and 235 ms; all trace 26’s will be muted between 

222 and 235 ms, etc.). 

 

† 6a MUTE 4 1 0 0 24 0 0 
 

† 6b MUTE 5 1 57 70 24 222 235 
 

† 6c MUTE 6 1 0 0 24 0 0 
 

† 6d  MUTE 19 1 57 70 24 222 235 25 0 0 
 
† Note: Not appropriate for this data set—used here only as an example. 

 

The MUTE sequence defined by lines 6a through 6c will operate only on record (SSN) 5.  Mutes defined 

for records 4 and 6 will terminate the interpolation process. The operation of the mute in regard to 

interpolation is very similar to FARM as defined in the section on *EDKL.  Any traces within this record 

greater than 24 will be muted as 24.  In order to stop the interpolation beyond trace 24, a zero mute 

window needs to be defined for trace 25.  Line 6d defines a mute exactly the same as 6b, except it terminates 

the muting of traces beyond trace 24. 

 

7 *OUTF EDMT.dat See *EDKL for description of *OUTF. 

 

8 >>END See *EDKL for description of >>END. 

 

The EDMT.dek text file will contain: 

 

>>start 

*inpf edfm.dat 

*edmt 92 8 

tapr 10 

mute 5 1 57 70 24 222 235 

*outf edmt.dat 

>>end 

 

 Use the “WinEdit.exe” GUI and choose Edit > Edit Options > EDMT-Surgical Mute from the main 

menu to visually select part of traces to be zeroed. Each mouse-click selection on the seismic-data image 

will be simultaneously written into the text file utility, “Cmdedit.exe”. See WinSeis User’s Manual (i.e., 

pages 1-13 and 1-14 of “4section1.pdf”) 

 

Double click on the EDMT.dek file to launch “WSeis.exe” and run the .dek file. 

 

As before, while the program is running, it updates the user of where it is in the processing sequence described in 

EDMT.dek.  The EDMT.lst file is simply a journal file keeping track of the same information that the user will 

see on the screen during the actual running of Wseis.exe.  To see what has been saved in the journal file, use the 

MS-DOS TYPE command.  It is always good to at least briefly look at all the data after any operation.  To see what 

the effect of the mute has had on the input data EDFM.dat, use the view routine as described in previous sections. 
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The sample data set provided was muted to remove the air-coupled wave.  Anytime a mute is applied to seismic 

data, it should be as well defined and as tight as possible.  This is to avoid removing subdued signal.  The muting 

process zeros samples, and once a sample is zeroed, the information contained within that sample has been 

permanently removed.  For this reason, be extremely cautious when defining and applying a mute.  The plot of 

SSN 5 before and after the surgical mute (Figure 8) clearly shows the effect of the mute, as well as the narrowness 

of the defined mute window. 

 

 

Figure 8. Field file 5 a) before and b) after surgical mute performed. 
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SORTING (GATHERING) INTO CDP FORMAT 

The way data are organized for display and analysis is the heart of any seismic-reflection program.  Having flexi-

bility to look at data in a variety of ways is critical for future digital enhancement as well as discrimination of subtle 

features.  The actual sorting routine is not particularly difficult from a conceptual point of view, but it does require 

a significant amount of information relating to the acquisition geometries of the multichannel data.  The sheer 

number of parameters and geometric configurations that need to be defined make sorting potentially the most 

mistake-prone part of processing seismic data.  Built into the sorting operation are several ways to cross-check the 

accuracy of the user input information.  These processes are not completely automated, however, and the user must 

request and check the output of these operations to verify correctness of their parameter and geometry assignments. 

 

Sorting any seismic data can be thought of as very similar to playing gin rummy.  The main goal is to order the data 

or cards into a sequence likely to be of the most use later.  For example, in rummy you may be collecting by suit; 

with seismic data you may be collecting by receiver locations.  In rummy you may be collecting by face value; in 

seismic you may be collecting by common-midpoints.  With the card game, the identification (value [numeric or 

other] and suit) is displayed on the face of each card; with seismic data, the identification (location and size) is 

contained within each trace header.  In order for the data to be brought together in a meaningful fashion, you must 

select which particular identification (parameter) is most significant for this data set and future processing routines.  

The data can be gathered together, ordered, and reordered a variety of times and ways. 

 

The two most commonly used parameters to sort are CDP (common-depth-point) sometimes referred to as CMP 

(common-midpoint), and common source-to-receiver offset (common offset, for short).  Sorting according to 

common source-to-receiver offset is exactly what it sounds like.  All traces are gathered according to like distances 

from source to receiver. For example, each of the 24 traces recorded within each field file of our sample data set is 

offset from the source by a unique distance.  Therefore, gathering according to a common offset distance will result 

in 24 different primary groups (each with unique source-to-receiver offset), each containing 20 traces.  In good data 

areas, once the appropriate corrections are made for offset and elevations, common-offset data (if collected within 

the optimum window) can be viewed as a geologic cross-section without future digital enhancement.  However, 

seldom will common-offset data yield as much or as detailed information as a properly processed CDP stacked 

section.  WinSeis 1.8 is specially designed to enhance reflection information once the data are in a sorted CDP 

format. 

 

Good, complete field notes are critical to correct and accurate defining of source and receiver geometries, surface 

features, and events significant to future analysis.  The information that must be contained in the field notes for each 

recorded shot at each shotpoint includes: 

 

1) shotpoint station number 

2) live receiver station numbers relative to seismograph channel numbers 

3) roll switch number 

4) individual digital file name/number 

 

The items listed below need to be included in field notes, but only once per day unless they change during acquisi-

tion of the data. 

 

5) sample interval/number of samples 

6) analog-to-digital filter settings 

7) anti-alias filter 

8) type, number, and relative orientation of sources and receivers 

9) profile location and purpose 

10) any unusual offsets (inline or offline) 

11) comments or remarks 

12) time 

13) weather conditions 
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14) system (seismograph) error messages 

15) reminder to do system QC checks 

 

An example of a field notebook that we used quite successfully at the time this data was collected in England is 

displayed in Figure 9. 

 

Figure 10 shows the field notes that were collected for the sample dataset.  All significant information about the 

source and receiver geometries as well as acquisition parameters are provided.  The 20 field files used for this 

example data set (615-634) were extracted from a larger data set containing 39 files (601-639).  Building a batch 

processing file to define source and receiver geometries for our sample data set requires geometrically relating the 

20 shotpoints and the 43 receiver locations used during the acquisition of the section of the line used as our sample 

data set. 

 

The primary task associated with sorting the data relates to the assignment of geometries and parameters.  Trace-

header information plays a significant role in this operation. The following trace-header words are the most 

important to commit to memory. 

 

Header Word # Identifies 

 

   6 the field file number/name under which this trace was stored after it was recorded 

  8 this trace’s number within the field file it was collected under  

(also is equivalent to the channel number this trace was recorded at) 

12 this trace’s corresponding CDP number  

(usually about twice the associated station location) 

 14 the order of this trace within the appropriate CDP 

 19 distance this trace is from the source 

 86 station number of the receiver that recorded this trace 

 87 station number of the source associated with this trace 

 92 the source sequence number of this trace, which sequentially relates it to  

individual field files collected for a particular profile 

 

A helpful aid in defining the geometries, and to double check the accuracy of the field notes, is a stacking chart 

(Figure 9).  The layout of the stacking chart (by design) allows visual correlation between the field notes and the 

sort batch file.  It will simplify both visualizing and defining geometries for particular Source Sequence Numbers 

(SSN).  

 

Figure 11 defines station locations on the x axis and field file numbers as the y axis.  Each individual field record 

(file) number (y axis) has an associated set of 24 recording channels and a shotpoint.  The shotpoint location for a 

particular field record is identified by an X located beneath the appropriate station location (x axis).  Along with 

this X defining the shot location is the assigned source sequence number (SSN).  Each live receiver location is 

represented along the x axis by the appropriate seismograph channel number.  Notice the step-by-step progression 

of the shot and receivers across the line.  Figure 11 was broken up into three sections to fit a normal sheet of paper.  

Figure 12 identifies the locations and SSN, original field channel pairs and fold (redundancy, percent coverage) for 

each CDP.  The lower portion of the stacking chart was derived from the upper part.  The CDP numbers identified 

along the x axis on the lower part are exactly double the surface location defined directly above in the upper portion 

of the chart.  The number pairs beneath each CDP location identify the SSN and seismograph channel number for 

the trace(s) sampling this particular midway point between source and receiver (CDP).  As an example, locate SSN 

5 and seismograph channel number 10 on the upper portion of the stacking chart.  Next, find the point which is 

midway between the shot for SSN 5 and the associated seismograph channel 10.  Finally, extrapolate that point 

straight down into the lower portion of the chart and the user will find the number pair 5,10 as the fifth set of number 

pairs beneath CDP location 240.  The numbers on the bottom row running parallel to the x axis identify the fold of 

the associated CDP. 
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Figure 9. Sample field notebook page. 
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Figure 10. Sample field notebook filled with notes recorded in the field. 

 
The fold can be figured by simply adding the number of SSN/trace number pairs beneath each CDP location.  Figure 

12 was broken up into three sections to fit a normal sheet of paper.  

 

The program WSeis has an option to print a table which will allow the user to directly compare their hand-generated 

stacking chart directly from the field notes with a computer-generated chart reflecting the geometries and parameters 

the user defined for the *SORT operation.  Our computer-generated chart for the sample data set will be compared 

to the hand-generated chart (Figure 11) after our sort deck is complete. 
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 Station Location 

 
108 109 110 111 112 113 114 115 116 117 118 119 120 121 122 123 124 125 126 

field file # SSN                    

615 1 1X       1 2 3 4 5 6 7 8 9 10 11 12 

616 2  2X       1 2 3 4 5 6 7 8 9 10 11 

617 3   3X       1 2 3 4 5 6 7 8 9 10 

618 4    4X       1 2 3 4 5 6 7 8 9 

619 5     5X       1 2 3 4 5 6 7 8 

620 6      6X       1 2 3 4 5 6 7 

621 7       7X       1 2 3 4 5 6 

622 8        8X       1 2 3 4 5 

623 9         9X       1 2 3 4 

624 10          10X       1 2 3 

625 11    X=source location     11X       1 2 

626 12            12X       1 

627 13             13X       

628 14              14X      

629 15               15X     

630 16                16X    

631 17                 17X   

632 18                  18X  

633 19                   19X 

634 20                   20X 

 
 

Station Location 

 
127 128 129 130 131 132 133 134 135 136 137 138 139 140 141 142 143 144 145 

field file # SSN                    

615 1 13 14 15 16 17 18 19 20 21 22 23 24        

616 2 12 13 14 15 16 17 18 19 20 21 22 23 24       

617 3 11 12 13 14 15 16 17 18 19 20 21 22 23 24      

618 4 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24     

619 5 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24    

620 6 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24   

621 7 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24  

622 8 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 

623 9 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 

624 10 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 

625 11 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 

626 12 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 

627 13 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 

628 14  1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 

629 15   1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 

630 16    1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 

631 17     1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

632 18      1 2 3 4 5 6 7 8 9 10 11 12 13 14 

633 19       1 2 3 4 5 6 7 8 9 10 11 12 13 

634 20       1 2 3 4 5 6 7 8 9 10 11 12 13 

 
 

Station Location  

 
146 147 148 149 150 151 152 153 154 155 156         

field file # SSN                    

615 1                    

616 2                    

617 3                    

618 4                    

619 5                    

620 6                    

621 7                    

622 8  1-24 trace# (channel#)                

623 9 24                   

624 10 23 24                  

625 11 22 23 24                 

626 12 21 22 23 24                

627 13 20 21 22 23 24               

628 14 19 20 21 22 23 24              

629 15 18 19 20 21 22 23 24             

630 16 17 18 19 20 21 22 23 24            

631 17 16 17 18 19 20 21 22 23 24           

632 18 15 16 17 18 19 20 21 22 23 24          

633 19 14 15 16 17 18 19 20 21 22 23 24         

634 20 14 15 16 17 18 19 20 21 22 23 24         

Figure 11. Stacking chart. 
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A stacking chart may not always be necessary, but until a great deal of experience is gained processing seismic 

data, it is a wise aid in assuring the data the user is preparing to gather and stack are properly identified and ordered. 
 

Once the user has a complete set of field notes and knows how to order the data for future digital enhancement and 

display, the user is ready to create a batch process file to sort data. 

 

The following deck is built for CDP sorting of a sample data set that is composed of 20 shots recorded on a 24-

channel seismograph across 44 receiver stations, each separated by 2.5 m.  The source-to-closest-receiver distance 

is 17.25 m and the source stations are coincident with the receiver stations.  The data were collected using a CDP-

type roll-along technique.  The relative source-to-receiver orientation was end-on. 

 

Line Description 

 

1 >>START See *EDKL for description of >>START. 

 

2 *INPF EDMT.dat See *EDKL for description of *INPF. 

 

3 *SORT 12 19 

 

The *SORT procedure calls the subroutine responsible for collecting traces according to indicated 

header words.  We have described a sorting operation here which will gather together all traces with 

equivalent midpoints between shot and receiver.  The first value (header-word number) input designates 

the primary sort grouping (trace header word 12, CMP or CDP number).  The second value (header-

word number) requested designates the secondary grouping (trace header word 19, distance from 

source to receiver).  The secondary grouping simply designates the ordering of the trace display within the 

primary grouping.  With unprocessed field data, the primary grouping is file or source-sequence number, 

and the secondary grouping is according to individual trace or channel numbers. 

 

4 PTRN 2.5 24 1 

 

The PTRN operation defines the distance between surface stations and physical seismograph param-

eters.  This operation must always precede the *SORT procedure definition.  The first requested input is 

the distance between station locations (2.5 m).  The second value to be identified is the total number of 

recording channels on your seismograph (24).  And the final value represents the units of length used 

during the acquisition of the data (1 = meters, 0 = feet).  This operation (PTRN) is the lead-in for the next 

line(s) (PN), which will identify all the different source and receiver geometries used throughout the 

collection of this data set. 

 

  S 1 24 trace/channel 

5a PN 1 108 115 24 1 # * * * * * * * * * * * * * * * * * * * * * * * * 

  108 115 138 surface station 

 

Note:  A piece of the stacking chart is represented above to help equate the 

station numbers to the actual source and receiver patterns. A stacking chart 

allows the user to visualize the relative locations of the shots and receivers. 

 

PN defines each unique relative source-to-receiver geometry. The pattern described on line 5a is 

designated as pattern number 1 (it will be referenced by that number (1) later in this batch job).  It defines 

a source location (108) and its associated first receiver location (115) as well as indicating consecutive 

receiver locations (24).  The fifth value designates the amount each surface station was incremented after 

each shot.  In this case, stations were incremented by 1.  In other words, station 115 equates to trace/ 

channel 1 of your seismograph; station 116 equates to trace/channel 2 of your seismograph. 
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Source Station 

Location (SSN) 

CDP Number 

223 224 225 226 227 228 229 230 231 232 233 234 235 236 237 238 239 240 241 242 

108 =   1 1,1 1,2 1,3 1,4 1,5 1,6 1,7 1,8 1,9 1,10 1,11 1,12 1,13 1,14 1,15 1,16 1,17 1,18 1,19 1,20 

109 =   2   2,1 … … … … … … … … … … … … … … … … … 

110 =   3     3,1 … … … … … … … … … … … … … … … 

111 =   4       4,1 … … … … … … … … … … … … … 

112 =   5         5,1 … … … … … … … … … … … 

113 =   6           6,1 … … … … … … … … … 

114 =   7             7,1 … … … … … … … 

115 =   8               8,1 … … … … … 

116 =   9        SSN, trace #       9,1 … … … 

117 = 10        e.g., 1,6         10,1 … 

118 = 11                     

119 = 12                     

120 = 13                     

121 = 14                     

122 = 15                     

123 = 16                     

124 = 17                     

125 = 18                     

126 = 19                     

127 = 20                     

Fold 1 1 2 2 3 3 4 4 5 5 6 6 7 7 8 8 9 9 10 10 

 
 

Source Station 

Location = SSN 

CDP Number 

243 244 245 246 247 248 249 250 251 252 253 254 255 256 257 258 259 260 261 262 

108 =   1 1,21 1,22 1,23 1,24                 

109 =   2 … … … … … 2,24               

110 =   3 … … … … … … … 3,24             

111 =   4 … … … … … … … … … 4,24           

112 =   5 … … … … … … … … … … … 5,24         

113 =   6 … … … … … … … … … … … … … 6,24       

114 =   7 … … … … … … … … … … … … … … … 7,24     

115 =   8 … … … … … … … … … … … … … … … … … 8,24   

116 =   9 … … … … … … … … … … … … … … … … … … … 9,24 

117 = 10 … … … … … … … … … … … … … … … … … … … … 

118 = 11 11,1 … … … … … … … … … … … … … … … … … … … 

119 = 12   12,1 … … … … … … … … … … … … … … … … … 

120 = 13     13,1 … … … … … … … … … … … … … … … 

121 = 14       14,1 … … … … … … … … … … … … … 

122 = 15         15,1 … … … … … … … … … … … 

123 = 16           16,1 … … … … … … … … … 

124 = 17             17,1 … … … … … … … 

125 = 18               18,1 … … … … … 

126 = 19                … 19,1 … … … 

127 = 20                 20,1 20,2 20,3 20,4 

Fold 11 11 12 12 12 12 12 12 12 12 12 12 12 12 12 12 13 13 12 12 

                     

 
 

Source Station 

Location = SSN 

CDP Number 

263 264 265 266 267 268 269 270 271 272 273 274 275 276 277 278 279 280 281 282 

108 =   1                     

109 =   2                     

110 =   3                     

111 =   4                     

112 =   5                     

113 =   6                     

114 =   7                     

115 =   8                     

116 =   9                     

117 = 10 … 10,24                   

118 = 11 … … … 11,24                 

119 = 12 … … … … … 12,24               

120 = 13 … … … … … … … 13,24             

121 = 14 … … … … … … … … … 14,24           

122 = 15 … … … … … … … … … … … 15,24         

123 = 16 … … … … … … … … … … … … … 16,24       

124 = 17 … … … … … … … … … … … … … … … 17,24     

125 = 18 … … … … … … … … … … … … … … … … … 18,24   

126 = 19 … … … … … … … … … … … … … … … … … … … 19,24 

127 = 20 20,5 20,6 20,7 20,8 20,9 20,10 20,11 20,12 20,13 20,14 20,15 20,16 20,17 20,18 20,19 20,20 20,21 20,22 20,23 20,24 

Fold 11 11 10 10 9 9 8 8 7 7 6 6 5 5 4 4 3 3 2 2 

Figure 12. CDP fold chart. 
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If the source was occupying (being fired) every station location but the receivers were located (live) at every 

other surface station, you would have used a 2 for the fifth input value to indicate the receiver spacing was 

twice the surface-station spacing.  Then surface station 115 would equate to trace/channel 1 and station 117 

would equate to trace/channel 2, etc.  Another possibility is that the roll switch is wired reverse to this 

sequence, which means your trace/channel 1 is at surface station location 138 when surface stations 115 to 

138 are selected.  If this is the case, the user would want to designate a negative one (-1) increment of 

surface-station locations as the fifth value input of the PN definition.  The correct PN definition for a 

reversed roll-switch would look like line 5b. 

 

  S 24 1 trace/channel 

† 5b PN 1 108 138 24 -1 # * * * * * * * * * * * * * * * * * * * * * * * * 

  108 115 138 surface station 

 

This definition indicates the surface station location of the shot was 108, trace/channel 1 was 138, and 

incrementing of station locations is negative (-1) with respect to the positive increasing trace/channel 

numbers. Therefore, channel/trace 1 is surface station 138, channel/trace 2 is surface station 137, channel/ 

trace 3 is surface station 136, etc. Here the same source-to-receiver maximum and minimum offsets are 

defined (source 108, minimum offset 115, maximum offset 138) as on line 5a, the exception of course being 

the decrementing surface station numbers with respect to the incrementing trace/channel numbers.  This is 

a critical difference when the source-to-individual-receiver distances are calculated later in this batch job.  

All the information necessary to determine exactly how to define the trace/channel orders is contained 

within the trace header and is easily viewed using the trace-header-dump (TRHD) routine previously 

discussed. 

 

  S 1 24 trace/channel 

† 5c PN 1 95 99 2 # * * * * * * * * * * * * * * * * * * * * * * * * 

  95 99 122 surface station 

 

The sorting routine does not care what the actual numbers input for the source (108) and receiver (115) 

locations are; it only looks at relative differences. What that means is the PN definition on line 5a is 

identical to the PN definition on line 5c. It is not necessary to define existing station numbers. It is advisable 

to identify the real station numbers to avoid confusion in the event that problems crop up later. 

 

This definition of pattern is exactly the same as the one defined on line 5.  The station numbers of the 

shot and receivers need only be relative to each other and do not need to be related to the actual values used 

in the field.  Any arbitrary numerical representation will work. 

 

  1 12 S 13 24 trace/channel 

† 5d PN 1 114 101 12 1 116 12 1 * * * * * * * * * * * *  #  * * * * * * * * * * * * 

  101 112  116 127 surface station 

 

This definition is of a split-spread pattern.  This definition does not apply to the acquisition parameters 

and geometries being defined here, but is included as an example in case you encounter a split-spread 

source-receiver geometry.  Briefly, this is the first pattern defined (1), the shot station number is 114, the 

first trace/channel station number is 101, there are 12 consecutive trace/channels defined across 12 

sequential surface station locations, then a 3-station skip to station location 116 which is trace/channel 13 

where the remaining 12 channels are defined as starting at 116 to 127, inclusive, each sequential increase 

of (1) in trace/channel number corresponds to a sequential increase of 1 in the surface-station location. 

 
† Not appropriate for this data set—used here only as an example. 
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6 SHOT 

 

The alpha character descriptor SHOT simply identifies the succeeding series of SN or SNSN definitions 

as they relate to the shot location and source sequence numbers (SSN). This operation must follow the 

PTRN operation. 

 

7 SN 1 108 1 0 0 1 

 

The SN definition input is required for each field file (source sequenced file).  This operation matches 

a source sequenced file with its appropriate shotpoint’s surface station location and source/receiver 

geometry, as described by the PTRN operation.  In this case, the SSN (Source Sequence Number) is 1, 

the shot station location is 108, and the source/receiver geometry is defined in PN 1. The fourth entry 

(0) is related to inline offset; this is simply the distance from the defined surface station location to the 

actual location of the shot recorded along the line of the survey (parallel offset).  The fifth entry (0) is also 

related to the actual location of the shot recorded at this surface location (109), and it defines the distance 

off the line between the shot and actual surface station location (perpendicular offset). The sixth value 

(1) identifies the repeat shot number.  Since we are only recording one shot per surface location, 1 is the 

appropriate sixth value.  The repeat shot number simply identifies which shot this file represents at this 

location.  If multiple shots are recorded individually at this location on different files, the program is capable 

of identifying which shot this file represents and then allows the option to later sort according to particular 

repetitive shot number at each location. 

 

8 SN 2 109 1 

 

This SN definition, as with the previous one (line 7), is required to describe the source station number and 

its associated live receiver pattern.  This must be done for each defined SSN.  The only difference between 

this SN definition and the one previous is that SSN 2 is defined with shot location 109, whereas the previous 

one was for SSN 1 with shot location 108.  The last three parameters were omitted on this definition because 

the default values were appropriate. 

 

The line format was purposely changed on line 8 simply to demonstrate the flexibility of formatting 

within the program.  This shows the program is not field sensitive with respect to the number of spaces 

between input parameters.  However, it should be kept in mind that the order of the input values is critical.  

If the user wishes to input values not identified as default values for the sixth and seventh requested 

parameters but the fourth and fifth are the same as the default values, the user must input all values from 

the first requested to the seventh, regardless of the default values.  (See line 10). 

 
9 SNSN < 2 19 1 > < 110 126 1 > 1 

 

The SNSN definition permits the assignment of field geometries to large numbers of sequential field files 

possessing identical shot and receiver patterns as well as source offsets and bad traces. The < > are treated 

as entry parameters and therefore need to be separated from other entries by a space.  Here we are defining 

the shot patterns for SSN 2 through 19, which relates to shot locations 109 to 126.  Both shot location and 

SSNs increment by 1 as the source and receivers move down the survey line.  Therefore, the first set of 

bracketed values represent the SSNs and increment of movement while the second set of bracketed values 

represent the associated shot locations and their increment pattern. The information within the first set of 

brackets is equivalent to the first entry on a normal SN definer. The second set of bracketed values is 

equivalent to the second entry on the normal SN definer. All parameters beyond the first two of the SNSN 

definers are identical to those of the ordinary SN definer. 
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10 SN 20 127 1 0 0 1 1 24 

 

This shotpoint definition has a couple extra entries in comparison to the previous SN definers.  The SN 

definition’s seventh value is the first dead trace/channel number and eighth value (24) is the last dead 

trace/channel number.  From the field notes for our sample data, the 19th and 20th shots were recorded 

at the same location.  In order to retain equal weighting of all shot locations across the line, one of the 

duplicate shots must be removed.  In this case, the second shot was deleted using the 7th and 8th values in 

the SN definition.  The program will interpolate between the seventh and eighth input values.  This means, 

if the seventh value is 19 and the eighth value is 22, the program will omit 19 thru 22, inclusive.  The 

previous SN definers have had the same inline and offline offsets as well as repeat shot number.  The 

information was not entered because the default values are appropriate (in other words if the user does not 

enter anything, or the required values, the program assumes the default values are correct). 

 

11 TABL 1 1 

 

The TABL operation is optional and allows the user to cross-check the defined geometries with the actual 

field geometries.  The two input values are flags.  The first (1) designates that the user wishes to have the 

receiver diagram plotted out, and the second (1) signals the printing of the SORT table.  The entire table 

will be contained within the list file (i.e., WINSEIS SORT.dek TABLE.lst where TABLE.lst is the 

journal file and it can be typed out or printed using standard MS-DOS operations). 

 

12 *OUTF SORT.dat See *EDKL for description for *OUTF. 

 

13 >>END See *EDKL for description for >>END. 

 

The SORT.dek text file will contain: 

 

>>start 

*inpf edmt.dat 

*sort 12 19 

ptrn 2.5 24 1 

pn 1 108 115 24 1 

shot 

sn 1 108 1 0 0 1 

snsn < 2 19 1 > < 109 126 1 > 1 

sn 20 127 1 0 0 1 1 24 

tabl 1 1 

*outf sort.dat 

>>end 

 

 Use the “WinSort.exe” GUI to use visual tools for entering source and receiver location (i.e., geometry). 

Each mouse-click selection on the seismic-data image will be simultaneously written into the text file 

utility, “Cmdedit.exe”. See WinSeis User’s Manual (i.e., pages 1-11 and 1-12 of “4section1.pdf”). 

 

Double click on the SORT.dek file to launch “WSeis.exe” and run the .dek file. 

 

The SORT.lst file is again a journal file that will contain not only the blow-by-blow account of the processing 

sequence; it will also contain the geometries and sorting sequences applied in accordance with the input information.  

This is intended to allow the user the option to compare the stacking chart developed from the field notes with the 

actual information the user coded into the various operations in the batch processing file.  The journal file will be 

contained in the subdirectory in which the user is running the “WSeis.exe” program and can be viewed in WinView. 
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The stacking chart, generated by the program (assuming the user used the TABL option) with the information input 

during the sort operation, is displayed on the next page. The output from the TABL option will generate a table 

similar to the above table which contains the SSN-trace pairs with their associated RCRD (CDP #) and appropriate 

fold.  Checking this (program generated) table against the one you constructed (Figure 9) will help verify the 

correctness of the sort file as well as assure you the data geometries are input correctly into the trace header. 
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SORTED RECORD TABLE (SHOT #1) 

 
RCRD FOLD SN-TR SN-TR SN-TR SN-TR SN-TR SN-TR SN-TR SN-TR SN-TR SN-TR SN-TR SN-TR 
  223 1 1-1 
  224 1 1-2 
  225 2 2-1 1-3    SN = shot # 
  226 2 2-2 1-4    TR = trace # 
  227 3 3-1 2-3 1-5 
  228 3 3-2 2-4 1-6 
  229 4 4-1 3-3 2-5 1-7 
  230 4 4-2 3-4 2-6 1-8 
  231 5 5-1 4-3 3-5 2-7   1-9 
  232 5 5-2 4-4 3-6 2-8 1-10 
  233 6 6-1 5-3 4-5 3-7   2-9 1-11 
  234 6 6-2 5-4 4-6 3-8 2-10 1-12 
  235 7 7-1 6-3 5-5 4-7   3-9 2-11 1-13 
  236 7 7-2 6-4 5-6 4-8 3-10 2-12 1-14 
  237 8 8-1 7-3 6-5 5-7   4-9 3-11 2-13 1-15 
  238 8 8-2 7-4 6-6 5-8 4-10 3-12 2-14 1-16 
  239 9 9-1 8-3 7-5 6-7   5-9 4-11 3-13 2-15 1-17 
  240 9 9-2 8-4 7-6 6-8 5-10 4-12 3-14 2-16 1-18 
  241 10 10-1 9-3 8-5 7-7   6-9 5-11 4-13 3-15 2-17 1-19 
  242 10 10-2 9-4 8-6 7-8 6-10 5-12 4-14 3-16 2-18 1-20 
  243 11 11-1 10-3 9-5 8-7   7-9 6-11 5-13 4-15 3-17 2-19 1-21 
  244 11 11-2 10-4 9-6 8-8 7-10 6-12 5-14 4-16 3-18 2-20 1-22 
  245 12 12-1 11-3 10-5 9-7   8-9 7-11 6-13 5-15 4-17 3-19 2-21 1-23 
  246 12 12-2 11-4 10-6 9-8 8-10 7-12 6-14 5-16 4-18 3-20 2-22 1-24 
  247 12 13-1 12-3 11-5 10-7   9-9 8-11 7-13 6-15 5-17 4-19 3-21 2-23 
  248 12 13-2 12-4 11-6 10-8 9-10 8-12 7-14 6-16 5-18 4-20 3-22 2-24 
  249 12 14-1 13-3 12-5 11-7 10-9 9-11 8-13 7-15 6-17 5-19 4-21 3-23 
  250 12 14-2 13-4 12-6 11-8 10-10 9-12 8-14 7-16 6-18 5-20 4-22 3-24 
  251 12 15-1 14-3 13-5 12-7   11-9 10-11 9-13 8-15 7-17 6-19 5-21 4-23 
  252 12 15-2 14-4 13-6 12-8 11-10 10-12 9-14 8-16 7-18 6-20 5-22 4-24 
  253 12 16-1 15-3 14-5 13-7   12-9 11-11 10-13 9-15 8-17 7-19 6-21 5-23 
  254 12 16-2 15-4 14-6 13-8 12-10 11-12 10-14 9-16 8-18 7-20 6-22 5-24 
  255 12 17-1 16-3 15-5 14-7   13-9 12-11 11-13 10-15 9-17 8-19 7-21 6-23 
  256 12 17-2 16-4 15-6 14-8 13-10 12-12 11-14 10-16 9-18 8-20 7-22 6-24 
  257 12 18-1 17-3 16-5 15-7   14-9 13-11 12-13 11-15 10-17 9-19 8-21 7-23 
  258 12 18-2 17-4 16-6 15-8 14-10 13-12 12-14 11-16 10-18 9-20 8-22 7-24 
  259 12 19-1 18-3 17-5 16-7   15-9 14-11 13-13 12-15 11-17 10-19 9-21 8-23 
  260 12 19-2 18-4 17-6 16-8 15-10 14-12 13-14 12-16 11-18 10-20 9-22 8-24 
  261 11 19-3 18-5 17-7 16-9 15-11 14-13 13-15 12-17 11-19 10-21 9-23 
  262 11 19-4 18-6 17-8 16-10 15-12 14-14 13-16 12-18 11-20 10-22 9-24 
  263 10 19-5 18-7 17-9 16-11 15-13 14-15 13-17 12-19 11-21 10-23 
  264 10 19-6 18-8 17-10 16-12 15-14 14-16 13-18 12-20 11-22 10-24 
  265 9 19-7 18-9 17-11 16-13 15-15 14-17 13-19 12-21 11-23 
  266 9 19-8 18-10 17-12 16-14 15-16 14-18 13-20 12-22 11-24 
  267 8 19-9 18-11 17-13 16-15 15-17 14-19 13-21 12-23 
  268 8 19-10 18-12 17-14 16-16 15-18 14-20 13-22 12-24 
  269 7 19-11 18-13 17-15 16-17 15-19 14-21 13-23 
  270 7 19-12 18-14 17-16 16-18 15-20 14-22 13-24 
  271 6 19-13 18-15 17-17 16-19 15-21 14-23 
  272 6 19-14 18-16 17-18 16-20 15-22 14-24 
  273 5 19-15 18-17 17-19 16-21 15-23 
  274 5 19-16 18-18 17-20 16-22 15-24 
  275 4 19-17 18-19 17-21 16-23 
  276 4 19-18 18-20 17-22 16-24 
  277 3 19-19 18-21 17-23 
  278 3 19-20 18-22 17-24 
  279 2 19-21 18-23 
  280 1 19-22 18-24 
  281 1 19-23 
  282 1 19-24 
>>end 
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It should be kept in mind that the stacking chart generated by the sorting operation (TABL) does not check the real 

input data to identify traces designated as bad.  Therefore, the SSN trace pairs, output with its associated CDP 

number, will include values previously deleted.  If your hand-generated stacking chart is correct, it will also include 

the dead or bad traces. 

 

It will be beneficial at this point to generate a hard copy plot of the entire sorted data set.  This will allow you to 

cross check your stacking chart with your sorting table printout as well as the actual sorted data.  Many times 

problems not obvious on a sorting table will be quite obvious on a hard-copy plot of CDP sorted data. 

 

The principal (higher amplitude) reflections identified on our raw field file (Figure 4) are still interpretable on the 

gathers of CDPs 245 and 246 (Figure 13). 

 

 

Figure 13. Shot gathers of CDPs 245 and 246. 

These two gathers represent the subsurface points located beneath station locations 122 1/2 and 123.  Careful exam-

ination reveals the zeroed-out portions of the traces previously occupied by the air-coupled wave.  The traces are 

ordered within each CDP according to original source-to-receiver offset distance (trace header word 19 as defined 

by the *SORT). The location of the traces within each CDP is also identified by a trace header word (14).  Header 

word 14 designates the order within the CDP gather.  The numbering of traces within the CDP is from left to right 

with the far left trace of CDP 245 possessing a 1 at trace header location 14, while the trace on the far right possesses 
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an 11 at trace header location 14.  Header word 14 is totally unrelated to header word 8 (original seismograph 

channel number) and may or may not be the same value. 

ELEVATION CORRECTION/DATUM ASSIGNMENT 

Correcting data for a variable near surface can be one of the most difficult problems encountered while processing 

seismic-reflection data.  Most areas on a seismic-reflection section possessing poor signal-to-noise ratios or that 

have resulted in an incorrect structural interpretation are pigeon-holed as related to “static problems.” These 

problems can be the result of anything from incorrect compensation for surface topography to uncompensated 

velocity irregularities in the near surface. 

 

On any data set, the first step in eliminating static effects requires adjustment of the data to a datum.  A datum is 

simply a reference line with some absolute correlation to sea level or, in some cases, average slope of the ground 

surface (sloping datum).  Generally, on conventional data the datum is chosen beneath the weathered and within 

the subweathered zone.  Defining the datum within the subweathered zone is necessary to ensure all non-uniform 

near-surface material is above the datum.  The correction conceptually involves removal of all material above 

the datum, which in turn ultimately allows accurate time-to-depth conversions relative to sea level on interpreted 

CDP stacked sections.  Correcting for both surface topography and a non-uniform weathered layer requires at least 

relative station elevations and a somewhat detailed knowledge of the near-surface velocity and depth structure.  

The datum correction is generally perceived as a first guess approximation and is intended to remove major static 

anomalies associated mainly with relative elevation changes. Discrepancies between the calculated datum correc-

tion and true datum correction are generally addressed using iterative numerical techniques at a later stage in the 

CDP processing flow. 

 

Shallow high-resolution reflection profiles generally target geologic features within what conventional wisdom 

would suggest is the weathered zone.  Correcting for elevation and near-surface irregularities on shallow profiles, 

therefore, becomes quite complicated in comparison to the previously described conventional procedure for datum 

corrections.  Detailed knowledge of shallow velocity and depth information is critical for accurate datum corrections 

on shallow-reflection surveys.  Subtle changes in the velocity of very-near-surface material can drastically affect 

the spectral as well as spatial properties of higher frequency data.  For example, if you are looking for structure on 

the bedrock surface at a depth of 12 m with an NMO velocity of 400 m/s and dominant reflection frequencies around 

200 Hz, an uncompensated 0.3-m variation in elevation or a 10 m/s velocity anomaly can result in a 100 degree 

phase shift in the recorded reflection wavelet. A gradual horizontally increasing near-surface velocity can be 

misinterpreted as a slope on the bedrock surface. 

 

The selection of a datum for shallow-reflection surveys can greatly influence the outcome and validity of the final 

interpretation of the data.  Many times reflection information of interest will be removed if a flat datum is chosen 

within the subweathered layer followed by conventional calculated removal of all overlying material.  For most 

shallow-reflection profiles, a datum should be chosen equal to the highest topographic feature on the survey 

line. Then the time adjustment to compensate for the missing material should be added to each trace in accord-

ance to the velocity/depth function.  In areas with alluvium over bedrock, generally a direct-wave velocity can be 

used to determine the appropriate time correction. In areas with either a thin layer of weathered material or no 

weathered material at all overlying outcropping or subcropping units, a more detailed velocity function is necessary 

to reconstruct the material between the present ground surface and the datum. For shallow-reflection data, the datum 

represents a pseudo ground surface composed of actual material beneath topographic highs and the virtual material 

used to compensate for the distance between the ground surface and topographic lows and the datum. The sum is 

the time between the ground surface and the datum, allowing depth calculations to bedrock or other layers. 

 

The most inaccurate part of the datum correction for shallow surveys involves the assignment of depth/velocity 

pairs to each surface station.  The best way to determine these values is through uphole/downhole surveys in 

strategically placed boreholes.  The WinSeis 1.8 software will generate a near-surface model along the survey line 

by incorporating all the uphole-determined velocity and depth information with the spatial distribution of the holes.  

Without uphole data, the only information available to approximate the near-surface velocity/depth 

© Kan
sa

s G
eo

log
ica

l S
urv

ey
  ©

 Kan
sa

s G
eo

log
ica

l S
urv

ey
  ©

 Kan
sa

s G
eo

log
ica

l S
urv

ey
 

 
 

 
 

 
© Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey

 

 
 

 
 

 
© Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey

 

 
 

 
 

 
© Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey

 

 
 

 
 

 
© Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey

 

 
 

 
 

 
© Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey

  ©
 Kan

sa
s G

eo
log

ica
l S

urv
ey



2020-08-13  

 WinSeis 1.8 — 2020 Tutorial 42 of 71 

structure is direct and refracted-wave information.  In some cases, the values obtained using this information 

are sufficient to generate an acceptable near-surface model.  The closer to a true near-surface velocity/depth model 

the user can define for the datum correction, the less dependent the user will be on iterative numerical statics routines 

and the more confidence the user will be able to put in depth calculations during the interpretation portion of the 

survey. 

 

However, with the elevation change present as a result of the wash-out, the *SURF determining the appropriate 

values to input into, and the usefulness of the output of the *SURF operation requires a thorough understanding of 

the geologic situation as well as certain physical properties of the near-surface materials. The input velocity 

function will be interpolated across the entire expanse of the defined profile line.  Elevation data input for each 

station location need only be relative within the survey (absolute elevation data are not necessary).  If the datum 

was assigned above the highest topographic feature on the survey line, the outputted static correction for each 

receiver and shot station will be necessary during the later interpretation stages to calculate depths.  If the datum 

was assigned within the subweathering zone, time-to-depth conversions can be made without knowledge of the 

amount of the static correction (material removed).  This is because the relative elevation of the datum is known, 

which in turn allows accurate determination of time values between the datum and event of interest. 

 

The necessary datum/elevation correction for our sample data set only modifies a small portion of the line.  The 

data were collected in a river valley.  River valleys often (as in this case) do not have significant changes in elevation.  

The majority of the sample data set was collected across a flat-lying pasture with little or no surface evidence to 

suggest areas of potential static anomalies.  At the extreme east end of the line, however, the line crossed a wash-

out extending approximately 6 m with a maximum relative depth of 1 m.  If not for the washout spot on the line, no 

datum correction or other operation would be necessary on this line at this time. 

 

Determination of the velocity within the very-near surface using the information provided with and contained within 

the sample data set is not straightforward.  Therefore, we will provide you with the velocity information as well as 

the relative elevation data necessary to properly calculate and apply the datum correction. An uphole velocity survey 

in conjunction with your seismic-reflection survey is advisable whenever possible to accurately determine the near-

surface velocity model. 

 

Average velocity from the surface to approximately 3 meters of depth is:    770 m/s 

 

Critical elevation information includes the following: 

 

 Station Location Relative Elevation (m) 

 

 136 0 

 137 0.3 

 138 0.6 

 139 0 

 140 -1 

 141 -0.3 

 142 -0.6 

 143 0 

 

Once as much information as possible is obtained about the near-surface materials, a batch processing file must be 

created to calculate the appropriate static values for each shot and receiver station.  This operation (*SURF) does 

not apply the calculated shifts.  This routine calculates the appropriate shift and updates the trace headers.  In order 

to apply this static shift, a *STAT 1 operation must follow the *SURF operation.  This can be accomplished either 

in the same or in a separate batch job file.  The following sequence of entries represents a batch processing file to 

calculate and apply datum corrections to our sample data set. 
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Line Description 

 

1 >>START See *EDKL for description of >>START. 

 

2 *INPF SORT.dat See *EDKL for description of *INPF. 

 

3 *SURF 100 

 

The *SURF identifier calls up the terrain correction subroutine from within WinSeis.  The required input 

value relates to defining the datum. The value of the datum is arbitrarily assigned as 100. In this case, think 

of the data as representing absolute elevation relative to sea level. 

 

4 ALVF 105 770 90 

 

ALVF defines the average velocities and their associated depths.  For the sample data set, we are defining 

a single velocity across the entire line and therefore the first entry identifies the maximum surface elevation 

(105) of the defined velocity function.  The second entry (770) defines the average velocity from the 

maximum surface (105) to a maximum depth identified by the third entry (90). 

 

 We have determined the following near-surface configuration: 

 

 
 

 The following example line 4a is appropriate for a case with multiple depth velocity pairs. 

 

† 4a ALVF 1000 1300 950 1600 900 

 

The ALVF operation defines the velocity model for the near-surface material down to a depth necessary to 

correct all station locations to the defined datum.  The values requested for the ALVF operation are:  the 

surface elevation (1000) of the defined velocity function, the average velocity (1300) from the surface 

(1000) to the elevation defined by the third numeric value (950), then the average velocity (1600) from 

the surface (1000) to the elevation defined by the fifth numeric value (900).  This sequence of average 

velocity/depth pairs continues until the entire velocity function is defined.  An important note at this point:  

the velocities defined here (ALVF) are AVERAGE VELOCITIES FROM THE SURFACE TO THE 

DEFINED DEPTH.  The program will calculate interval velocities for the defined intervals (1000-950, 

950-900).  This program works most effectively with uphole/downhole checkshot velocity information. 

 

 
 
† Not applicable to this data set—used here only as an example. 

 

5 SE 126 97 100 

 

The SE operation defines each station location and its associated source and receiver elevations. The 

defined values are station location (108), source elevation (97), and receiver elevation (100). The receiver 

elevation need not be defined if it is the same as the source elevation.  A shot elevation defined at a station 

where no shot was recorded will be sorted out by the program and properly handled. The program 
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interpolates horizontally and vertically between defined values and, therefore, stations 108 through 125 

are not defined since they are all the same as 126. 

 

6 SE 127 100 

 

7 SE 136 100 

 

8 SE 137 100.3 

 

9 SE 138 100.6 

 

10 SE 139 100 

 

11 SE 140 99 

 

12 SE 141 99.6 

 

13 SE 142 100.6 

 

14 SE 143 100 

 

15 *STAT 1 

 

The *STAT operation applies static correction values defined in the trace headers.  These static header 

words are updated by other operations (*AUTS, *SURF, or user input values).  The *STAT operation can 

be executed within the batch job where the actual static correction values are determined or later in a 

separate batch job either independently or with any other operation(s).  The only required input value 

(1) designates the type of operation used to define static shift values. 

 

16 *OUTF SURF.dat See *EDKL for description of *OUTF. 

 

17 >>END See *EDKL for description of >>END. 

 

At this point the user has completed the building of an executable file for the generation and application of 

static shifts to sorted data for the correction of elevation and near-surface irregularities across the profile. 

 

 The following commands should be in the batch file: 

 

>>start 

inpf sort.dat 

*surf 100 

alvf 105 770 90 

se 126 97 100 

se 127 100 

se 136 100 

se 137 100.3 

se 138 100.6 

se 139 100 

se 140 99 

se 141 99.6 

se 142 100.6 

se 143 100 

*STAT 1 
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*outf surf.dat 

>>end 

 

 Use the “Winstat.exe” GUI to use visual tools for near-surface information for static corrections. Each 

mouse-click selection on the seismic-data image will be simultaneously written into the text file utility, 

“Cmdedit.exe”. see WinSeis User’s Manual (i.e., pages 1-20 and 1-21 of “4section1.pdf”) 

 

The next step is to run the elevation correction job through the “WSeis.exe” program. 

 

An alternative way to apply the datum/elevation statics is to use the *STAT operation and directly input the amount 

of time shift necessary to compensate for variability in velocity and/or elevation to each station location across the 

line.  This way is very straightforward from an input point of view, but it does require significantly more work prior 

to interaction with the “WSeis.exe” program.  Described below is the appropriate way to correct the datum using 

the *STAT operation and the sample data set: 

 

Line Description 

 

1 >>START See previous description of >>START. 

 

2 *INPF SORT.dat See previous description of *INPF. 

 

3 *STAT 4 

 

*STAT identifies a time static operation.  The only entry necessary to do datum corrections is the first (4).  

The 4 simply indicates that the 4 option applies station corrections for both source and receiver. 

 

4 RECE 137 -0.30 
 

RECE identifies the trace header location that relates to the defined static shift.  The first entry (137) is the 

receiver station location of the defined shift (-0.3 ms), which is the third entry. The only requirement of the 

RECE definitions is that the numbers increase and that they be in sequential order. 

 

5 RECE 138 -0.6 

 

6 RECE 139 0 

 

7 RECE 140 1 

 

8 RECE 141 0.3 

 

9 RECE 142 -0.6 

 

10 *OUTF STAT.dat See previous description of *OUTF. 

 

11 >>END See previous description of >>END. 

 

As with all the batch files, it is advisable to type (list) them out after they have been constructed in a text or line 

editor.  The following is what the file STAT.dek should look like: 

 
>>start 
*inpf sort.dat 
*stat 4 
rece 137 -0.3 
rece 138 -0.6 
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rece 139 0 
rece 140 1 
rece 141 0.3 
rece 142 -0.6 
*outf stat.dat 
>>end 

 

Either the STAT 4 or SURF operation are valid ways to correct for variability across the seismic line. Which 

operation you use with various data sets other than the sample provided with this manual is dependent on the amount 

of static, other information available, and probably most important, which operation you are most comfortable with. 

 

VELOCITY ANALYSIS 

The compressional-wave (P-wave) velocity through an elastic media is related to Lame’s constants divided by the 

density of the media.  Normal moveout (NMO) velocity information derived from the curvature of reflection events 

on seismic data is used to correct each reflection wavelet for a non-vertical incident travel path.  The NMO velocity 

derived in this fashion can also be used as a rough approximation for the average velocity allowing a first-guess 

approximation of reflector depth. This correction for non-vertical incidence reflectors on seismic data (NMO 

correction) is one of the most critical parts of the preliminary processing flow. The summing of multi-fold data is 

meaningless unless all traces are corrected for their particular source-to-receiver offset to effectively simulate 

vertical incident energy (i.e., source and receiver located at the same point on the earth’s surface). 

 

Determining the appropriate stacking velocity (loosely NMO velocity) can be accomplished in a variety of ways.  

A constant velocity stack is the most commonly used method (probably because it does not require a significant 

amount of thought or understanding of the physics of the matter) to determine the stacking velocity of particular 

reflecting events on multi-fold seismic data. 

 

A constant velocity stack simply moves out and stacks all traces within a CDP gather at a predetermined velocity.  

Generally, a data set will be moved out and stacked at each of a consecutive group of velocities (in some cases as 

many as 20).  The analysis technique at that point simply involves visual inspection to determine which velocity is 

“best” for a particular reflector.  The velocity can and many times does vary both horizontally and vertically (time).  

The resultant velocity function is defined by CDP, time, and velocity.  Multiple reflectors should be identifiable at 

most CDPs on seismic reflection data collected in a geologic environment conducive to the propagation and 

recording of reflection energy.  The velocity function for each CDP will have an optimum stacking velocity paired 

with the appropriate time window for each identifiable reflector. The velocity function defined for a group of 

reflecting events at a particular CDP may not be appropriate for the same set of reflecting events at other CDPs 

across the profile (as a result of horizontal variability). Stacking velocities must be analyzed using the constant 

velocity stack and inputting large groups of CDPs across the entire expanse of the line. It is possible and many times 

advisable to analyze groups of CDPs from various spots across a seismic line until trouble spots or areas with need 

for a more detailed analysis can be located. 

Interactive Velocity Picking 

The most fundamental way to determine an approximate NMO velocity for a reflector is by using the exact NMO 

equation and a seismic field record. This process involves defining arrival time and source-to-receiver offset 

distance pairs and then putting them into the appropriate equation (for the appropriate equation see Telford et al., 

1976).  In order to streamline this process, WinSeis 1.8 has an interactive operation that allows the user to graphically 

determine the NMO velocity for a particular reflection event (“WinVelp.exe”). 

 

To start the process of determining the appropriate velocity function for our sample data set, we first will need to 

input a file into the “WinVelp.exe” program and determine an approximate velocity.  This will allow us to optimize 

computer and analysis time during the constant velocity stack portion where we will define our first-pass velocity 

function. The “WinVelp.exe” program requires the input data to already have the field geometries in the trace 
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headers.  To be consistent with the previous portions of this manual, we will use field file 5 to determine the velocity 

of our primary reflectors.  To get field file 5 into the correct format, we will need to resort the data from CDP to 

field file format so that the required header information is present.  With field file data as opposed to CDP gathers 

we will have 24 traces, allowing us significantly more trace-to-trace coherency.  More traces will also improve the 

statistical determination of velocity. 

 

First, we must resort the CDP sample data.  The following sequence in a batch file will accomplish this. 

 

Line Description 

 

1 >>START See previous description of >>START. 

 

2 *INPF SURF.dat See previous description of *INPF. 

 

3 *RSRT 92 8 

 

The *RSRT operation resorts data according to any trace-header word requested.  The first entry (92, which 

is the header word defining the SSN) defines the primary sort operation, which is the major groups to collect 

traces into (e.g., field files are grouped according to header word 6 or 92, CDP gathers are grouped 

according to 12; common offset gathers are grouped according to 19, etc.).  The second entry (8, which is 

the header word defining the trace number within the original field file) defines the secondary sorting 

operation, which is the order of the traces within each of the major groups defined by the first entry (channel 

number with each original field file are grouped according to 8; traces with each CDP are grouped according 

to 14; traces within common offsets are usually gathered according to header word 6, 87, or 92). 

 

4 *OUTF RSRT.dat See previous description of *OUTF. 

 

5 >>END See previous description of >>END. 

 

The resort batch file that was created with the above instructions will appear similar to the following: 

 

>>start 

*inpf surf.dat 

*rsrt 92 8 

*outf rsrt.dat 

>>end 

 

As with previous batch jobs, double click on the RSRT.dek file to launch “WSeis.exe” and run the .dek file. 

 

At this point, the file RSRT.dat is in field-file format.  One option at this point is to peel off only file 5 and input 

it into “WinVelp.exe”.  In “WinVelp.exe”, the option exists to select the desired field file on which to work.  We 

will remove only file 5 as an exercise in using the *INPF definer.  The following operation will result in a file being 

created containing field file 5 only: 

 

Line Description 

 

1 >>START See previous description of >>START. 

 

2 *INPF RSRT.dat 5 5 100 

 

The three entries after the input data-file (5 5 100) identify the beginning and ending file numbers to operate 

on and record length in meters.  The primary sort order of the data dictates file designation.  This means 

that if the data are in field-file format, the user can select particular field files to operate on, i.e., 5.  If the 
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data are in CDP format, the user can select a particular sequence of CDPs to operate on.  In this case, the 

input data (RSRT.dat) are in field-file format, allowing us to directly select field file 5.  It is not possible, 

however, to select a particular CDP or group of CDPs from this particular input data file (RSRT.dat) since 

it is in field-file format. 

 

3 *OUTF ff5.dat See previous description of *OUTF. 

 

4 >>END See previous description of >>END. 

 

To extract field file 5 from the rest of the data set, the previous batch processing file needs to be run as input to the 

program “WSeis.exe”.  Double click on the new FF5.dek file to launch “WSeis.exe” and run the .dek file. 

 

Now, field file 5 is the lone file in the MS-DOS file ff5.dat. 

WinVelp Tutorial 

Velocity analysis can be done by using the “WinVelp.exe” tool. Also See WinSeis Turbo Users Manual, Section 

1.4.1 Velocity (page 1-15). 

 

 

Figure 14. WinVelp main window. 

 
To open a .dat file, select Files > Open (ff5.dat).  Upon opening your file you will be prompted to input parameters 

regarding the geometry of the data.  To ensure your parameters are correct, click the “Visualize” button (Figure 

15).  This sets the display of your input parameters.  If everything is correct, click the “Done” button and your data 

will be displayed and ready for velocity analysis (Figure 16a). 

 

Once data are displayed, velocity analysis can be done by picking hyperbolas.  Simply click two or more wiggle 

traces in the shot record for a single reflection and click the “Vel” button for a velocity line to appear.  Velocities 

and Intercepts (time or depth) can also be entered for analysis. Upon clicking the “Vel” button, WinVelp calculates 

the NMO velocity (Vnmo), the two-way travel time at which that velocity is calculated (TO), and the depth at which 

at the reflection is located (Zdist). 
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Figure 15. “WinVelp Parameter Select” window with vertical display ratio 1:2 selected. 

 

After selecting two points along the >75 ms reflector by clicking on the image and clicking on the “Vel” button, the 

user should get a value of approximately 2400 m/s for the NMO velocity of the reflection at 75 ms, which equates 

to a depth-to-reflector of approximately 90 m (Figure 16b). 

 

a)      b)  

Figure 16. Field-file record 5 a) before picking a reflector and b) after picking a reflector at ~75 ms intercept time. 

In a similar fashion user can use CDP data gathers (Figure 17). However, such an approach may be more difficult 

due to the fewer traces available for picking (i.e., the CDP fold). 
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a)     b)  

Figure 17. CDP gather 260 a) before picking a reflector and b) after picking a reflector at ~75 ms intercept time. 

Constant Velocity Stack 

Once an established a ballpark velocity for the major reflecting events is determined it should be efficient to run  

the constant velocity stack routine (“Winvscn.exe”) to fine-tune the velocity function for this data set. The 

“Winvscn.exe” program is interactive and then once all the appropriate information is entered, it will operate on the 

input data as requested in a batch-type format. 

Velocity Scan Tutorial 

Once completing initial analysis using “WinVelp.exe”, further velocity analysis can be done using “Winvscn.exe”.  

“Winvscn.exe” has the ability to stack multiple CDPs and display multiple velocities for picking to ensure the most 

accurate velocity function.  It will also create a “.dek” file after picks are made.  “Winvscn.exe” allows for up to 20 

velocities and CDPs to be evaluated at a time.  To begin, open the “Winvscn.exe” and select a .dat file.  For this 

example, SURF.dat from the sample data will be used. Note: the data must be CDP (CMP) sorted for 

“Winvscn.exe” to work.  Upon selecting the file, the user will be prompted with an NMO Parameters screen.  This 

is where velocities and the number of CDPs can be defined.  More CDPs can be selected; however, for the purpose 

of this tutorial only CDP #223 and several velocities will be examined.  By checking the CDPs checkbox, 

“Winvscn.exe” will stack each group of 10 CDPs (223-232) and return the average. 
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Next input all necessary parameters: 

 

Output Length (ms) - 250 

 

This allows the option to process a small chunk of data (starting at time zero, of course).  This will be especially 

useful when more data are acquired than is really necessary. 

 

NMO Stretch Ratio - 0.60   

 

Sample stretch ratio defines the amount the user is willing to allow the wavelet to stretch as a result of the dynamic 

NMO correction before it is muted.  This parameter requires a great deal of care and careful thought before and 

after application.  Artifacts will be generated on stacked data if this parameter is not properly selected.  The result 

of an improper mute can range from apparent high-frequency coherent events to anomalous low-frequency shallow 

wavelets.  Experience and care will prevent trouble with this parameter.  With the extremely site-dependent nature 

of velocity functions, a simple rule of thumb is not possible.  This is a case where having the appropriate experience 

or academic background to understand the mathematics of the operation will greatly enhance the ability to properly 

select mutes and to know from inspection of stacked data if the mute was not properly assigned. 

 

Check the “Stack CDPs” checkbox. 

 

This allows inspection of data after moveout either in a stacked or unstacked form.  The unstacked form is very 

helpful in some cases because it will show exactly how much each trace was moved out and the associated 

contribution of each trace to the final stacked section. 

 

Select “# of Velocities” value, e.g., 13, and type the velocities in the corresponding fields (Figure 18). 

 

#1velocity   =  1800 

#2velocity   =  1900 

#3velocity   =  2000 

#4velocity   =  2100 

#5velocity   =  2200 

#6velocity   =  2300 

#7velocity   =  2400 

#8velocity   =  2500 

#9velocity   =  2600 

#10velocity =  2700 

#11velocity =  2800 

#12velocity =  2900 

#13velocity =  3000 

 

When entering trial velocity values, no set pattern or limits (except for maximum number of trial velocities) need 

be adhered to.  Finally, select File > Output file name, change the file type to .nmo, and enter a filename. Once 

complete, select the Open button in the bottom right corner and the Output filename should appear in the lower 

right corner of the dialog box. Click on the “Generate Panels” button to run the processing and the “OK” button 

once it is complete (Figure 18).  Now go back to the Files tab, select Open, once again change the file type to 

NMO data, and select your “.nmo” file (Figure 19). 
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a)   b)  

Figure 18. a) “NMO Parameters” window for entering constant-velocity-stack velocities and b) “VSCN-Move out 

completed” window. 

 

 

Figure 19. “WinVscn File OPEN” window before selecting an *.nmo file. 

 

The VSCN data will be displayed and the move-out velocity of each panel will be displayed in the upper right hand 

corner of the group of CDPs processed (Figure 20). 
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Figure 20. 1800 to 2400 constant-velocity panels. 

The display format for the constant velocity stacks groups all the CDPs according to stacking velocity.  The constant 

velocity panels will be either stacked (Figure 20) or unstacked depending on what is selected. Click on 

Options > Change Graphics to display the “Graphics Parameters” window and adjust display parameters (Figure 

21). 

 

 

Figure 21. Constant-veloctity panels “Graphics Parameters” window. 

Displaying the constant velocity stacks is critical and will be the first real glimpse of what a stacked section may 

look like once it has completed the processing flow. It is important to generate a hard copy of the velocity scans.  

This will give you a perspective of the relative quality of each reflector on each CDP at each of the selected 

velocities.  Picking a velocity function is the most significant, pure judgment call made yet in our processing of this 

sample data et. Select the best velocity function (which could involve several CDP, time, and velocity groups across 

the expanse of the line) for the entire line.  It should also be noted that at this point, a general knowledge of the 

geologic environment is critical to selecting a meaningful velocity model. This is mainly due to the variety of ways 

some reflection (or worse, noise) energy will “stack in” at different velocities. Distorting (creating) reflections as 

a result of incorrectly processing the data is not only possible, it is very easy if care is not taken during each step 

of the processing flow. 
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Using 50 CDPs can provide additional perspective (Figure 22). The 75 ms reflection in our sample data set changes 

velocity from about 1925 m/s to 2600 m/s across a distance of about 70 m.  There was no surface feature that would 

suggest such an extreme variability.  This in itself should encourage care during the velocity-analysis portion of the 

processing flow. 

 

 

Figure 22. 1900 and 2600 constant-velocity panels using 50 CDPs. 

 

The selection of the appropriate velocity function from constant velocity stacks is to some degree a qualitative 

judgment based mainly on experience and a fundamental knowledge of seismology and the site geology.  The odds 

of avoiding bogus reflecting events are increased by studying constant-velocity gathers.  Moved out gathers at this 

point in the processing flow are for the most part trace-by-trace the same (except for the extreme cases with a slight 

static shift) as the original recorded data. The only difference is the whole trace dynamic test moveout compensation 

(which is the variable being tested). Analysis of data in this fashion allows the user to go back to the original field 

files and actually follow identifiable reflection information through the velocity analysis. The velocity function that 

is chosen in this fashion should possess a high level of reliability once the data are actually stacked, and will reduce 

some of the qualitative aspects of the selection routine. 

 

Once you have displayed your data, you may click reflections at different velocities.  A cyan-red line will appear at 

your pick (Figure 23).  Once all of your velocities have been selected for a given CDP, click the “Next” button to 

evaluate the next CDP.  Once all CDPs have been analyzed and picked, select Options > Make VELF commands.  

This will make your .dek file for you, which would enable you to apply the different NMO velocity functions across 

the CDP data using the *NMOT command (WinSeis Turbo User’s Manual, p. 5-21). You will then be asked to 

select an output file name to be saved for NMO corrections to be applied, the NMO stretch mute you would like to 

apply, if you would like to use recording delay time, and the name of the .dek file. This can be saved and run through 

“WSeis.exe”. 
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Figure 23. 2500 to 3000 constant-velocity panels with two picked velocities, 2600 at 58 ms and 2700 at 89 ms indicated 

by cyan-red lines. 

 

 

Figure 24. Saving a .dek file with NMO velocity functions. 

See also WinSeis Turbo User’s Manual, Section 1.4. 

 

Within this tutorial, this file does not need to be saved—you are provided an NMO .dek file.  It was necessary to 

go through these steps to learn the uses of the tool and understand how this given .dek file was created.  When 

running the provided NMO.dek through “WSeis.exe”, a 2D velocity spectrum is created and plotted for you once 

the .dek file has completed (Figure 25). Check the “WSEIS18Manual-Amendments.pdf” (located in your 

C:\WSeis18\Documents\Manual folder) for more NMO parameters in addition to the ones listed in the WinSeis 

User’s Manual (i.e., page 5-21 of “8section5.pdf”), including the type of velocities to display (e.g., stacking vs. 

depth, etc.), inverse NMO, and additional NMO terms. 

 

The number of (CDP) groups to be processed often allows the user to skip through the line and do velocity analysis 

on sequential groups of CDPs.  If we wanted to do velocity analysis in an area we deemed to have velocity problems, 

or if we only wanted to do reconnaissance velocity analysis on certain portions of the line, several groups of CDPs 

could be selected for analysis. If velocity problems were present between CDPs 230 and 240 and between CDPs 

260 and 270, a constant velocity stack on just those two sequential groups of CDPs could be performed. 
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Figure 25. 2D Stacking velocities display. 

 
Effectively, the program increments 30 from the first CDP of the first group to determine where to begin the process 

for the second group. Therefore, in this case the second group would start with CDP 260 and 11 CDPs would be 

processed (240 - 230 = 11), up to and including CDP 270.  Likewise, if sufficient data existed, the third group would 

have started with CDP 290 and ended with CDP 300.  If 15 had been selected as the increment value, CDP 245 

would be the first CDP of the second group and CDP 255 would be the last. Then the third group (of the 15-

increment example) would have started with CDP 260 and ended with CDP 270. 

Time-Spatial Varying NMO 

The velocity function we choose for this data set is listed below: 

 

CDP Limits Time (ms) Velocity (m/s) 

 

200 - 232 0.0-50 1850 

 50-100 2600 

 100-135 2900 

 135-250 3000 

 

232 - 246 0.0-50 1850 

 50-100 2450 

 100-135 2900 

 135-250 3000 

 

246 - 253 0.0-50 1850 

 50-100 2450 

 100-135 2900 

 135-250 3000 

 

253 - 278 0.0-50 1850 

 50-140 1900 

 140-250 2250 
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278 - 290 0.0-50 1850 

 50-100 2450 

 100-250 2900 

 

The above described velocity function needs to be applied to the sorted, datum-corrected data. In order to 

accomplish this, a normal-moveout operator needs to be used.  The batch processing file (NMOT.dek) used to apply 

the normal-moveout correction to our sample data set is created and dissected below: 

 

Line Description 

 

1 >>START See previous description of >>START. 

 

2 *INPF SURF.dat See previous description of *INPF. 

 

3 *NMOT .6 0 0 1 

 

The *NMOT operator adjusts each sample of each trace (dynamic correction) for a specific velocity 

function described by the VELF definer. The only entry required for the NMOT operator is the value of 

the sample stretch ratio (0.6). Again, see “WSEIS18Manual-Amendments.pdf” for more NMO param-

eters.  This value specifies the amount of mute to apply to a trace to suppress the stretching of the reflection 

wavelets due to the correction of non-vertically incident ray paths.  By correcting to vertical incidence, all 

traces should be geometrically equivalent and whole-trace addition within a particular CDP should result 

in enhancement of reflection energy.  As discussed during the WinVSCN operation, a proper NMO stretch 

mute is critical to generating a realistic stacked section.  An incorrectly designed and applied stretch 

mute can generate (depending on whether the mute is too extreme or too subtle) anything from high-

frequency spikes to very distorted low-frequency wavelets.  The stretch mute is most evident on shallow 

low-velocity reflections.  This is because the most extreme stretch results from lower NMO velocities (as 

is intuitively obvious from a hyperbolic curvature perspective). The more severe hyperbolic NMO curvature 

(lower average velocity) is generally associated with the low-velocity material in the near surface. 

 

4 VELF 230 45 1850 60 2600 90 2600 110 2900 135 3000 

 

The VELF definers are grouped according to CDP locations.  The velocity function is input in time/velocity 

pairs.  The first entry after the VELF definer is the CDP number (230), for which this velocity function is 

defined. The second (45, in units of ms) and third (1850, in units of m/s) entries identify the first 

time/velocity pair of the velocity function at this CDP.  The program uses the first pair to define a consistent 

velocity window from 0 ms to the first identified time (45).  The velocity function is then interpolated 

between 45 and the third entry (60), which is the time value for the second time/velocity pair, with 1850 m/s 

defined as the velocity at 45 ms, gradually changing sample by sample until at 60 ms the NMO velocity is 

2600 m/s.  This process continues in exactly the same fashion for all the defined time/velocity pairs down 

to the bottom of the record.  In this case, the velocity is constant (2600 m/s) between 60 and 90 ms.  Then, 

between 90 and 110 ms, the NMO velocity changes from 2600 m/s to 2900 m/s. Finally, between 110 ms 

and 135 ms the NMO velocity is defined to change from 2900 m/s to 3000 m/s, where it remains constant 

to the end of the record. It should be noted that the last time/velocity pair initiates a constant velocity 

correction that begins at the last time identified and continues to the end of the record (Figure 26). 
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Figure 26. NMO velocity function at CDP 230. 

 

5 VELF 235 45 1850 60 2450 90 2450 110 2900 135 3000 

 

The velocity function for this VELF definer is for CDP 235.  The vertical (time) interpolation process is 

identical here as it was with line 4 (previous VELF definer).  The significant thing to note here is the 

interpolation between CDP 230 and 235.  The interpolation process is uniform between lines 4 and 5 with 

the velocity defined at 60 and 90 ms gradually changing at each CDP between 230 and 235 from 2600 

to 2450 m/s. This will be true for all velocities defined at each VELF definer. The velocity will be 

interpolated in both time and space. 

 

6 VELF 250 45 1850 60 2300 90 2300 110 2900 135 3000 

 

7 VELF 255 45 1850 60 1900 110 1900 150 2250 
 

8 VELF 275 45 1850 60 1900 110 1900 150 2250 

 

9 VELF 280 45 1850 60 2450 90 2450 110 2900 

 

10 *OUTF NMOT.dat See previous description of *OUTF. 

 

11 >>END See previous description of  >>END. 

 

As you can see, the velocity function as it is defined here is not 

identical to the velocity function determined from the constant 

velocity stacks (listed in the table at the start of the Velocity 

Analysis Section).  The reason for this is related to the interpolation 

process operating both vertically in time and horizontally in space.  

Analysis of the data suggested specific time windows where the 

stacking velocity seems to be relatively constant and other time 

windows where, simply from a physically realistic point of view, 

the average velocity through the rock must be changing at a 

significant rate.  With this in mind, the program must be instructed 

as to which time windows have relatively constant velocities and 

which windows have a significant amount of change/unit time 

(depth).  The assigning of a realistic velocity function that possesses 

significant variability in time and space is a skill (knack) that will 

develop with time and experience. 
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It is wise to double check that the batch file has been created and saved the way it was intended.  The batch file 

should appear similar to the following: 

 

>>start 

*inpf surf.dat 

*nmot 0.6 

velf 230 45 1850 60 2600 90 2600 110 2900 135 3000 

velf 235 45 1850 60 2450 90 2450 110 2900 135 3000 

velf 250 45 1850 60 2300 90 2300 110 2900 135 3000 

velf 255 45 1850 60 1900 110 1900 150 2250 

velf 275 45 1850 60 1900 110 1900 150 2250 

velf 280 45 1850 60 2450 90 2450 110 2900 

*outf nmot.dat 

>>end 

 

Applying the defined velocity function (making the dynamic correction for non-vertical incidence) requires the 

execution of the batch processing file we just created called NMOT.dek.  Double click on the NMOT.dek file to 

launch “WSeis.exe” and run the .dek file. 

 

As before, the program will notify as to its progress.  In order to see the results of the velocity correction, use the 

view routine on the CDP gather.  The velocity function we just applied will correct the reflection for non-vertical 

incidence.  The result of this dynamic correction is quite evident when comparing corrected to uncorrected field 

files. 

 

The optimum stacking velocity should remove the hyperbolic curvature of a reflecting event (Figure 27a).  The 

result of the correct velocity on raw field files is trace-by-trace consistency in the time and wavelet characteristics 

of the reflecting event (Figure 27b). It is possible to examine NMO corrected data in field file format and compare 

it to data before the NMO correction (Figure 27a), as record gathers. For that the NMO output file, “nmo.dat”, can 

be reordered/resorted the from CDP gathers to common shot gathers, similar to the use of the *RSRT command in 

the “Interactive Velocity Picking” section. 
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a)     b)  

Figure 27. Field-file 5 a) before and b) after NMO correction for comparison (from Figure 8). 

SPECTRAL ANALYSIS 

The spectral characteristics of a raw seismic data trace are dependent on the acquisition parameters (and equipment) 

as well as the surface and subsurface characteristics of the site.  During the spectral analysis portion of the processing 

flow, the frequency characteristics are determined with respect to the various types of seismic energy present on the 

data. A frequency filter is then designed to enhance the favorable spectral characteristics and attenuate the undesir-

able ones. The amount and type of spectral analysis necessary for a particular data set is totally dependent on that 

data set. 

Frequency vs. Amplitude 

Depending on the data set, the first step in determining the spectral characteristics of seismic data is to define the 

dominant frequency and bandwidth of the entire data set.  This is most effectively done with an amplitude-versus-

frequency display.  This analysis technique relies on an FFT to compute the amount (amplitude) of information on 

a seismic trace at each particular frequency.  This operation will become less necessary (depending on the data set) 
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as the user gains more experience looking at seismic data and identifying particular types of energy and their 

dominant frequencies.  Until that point, amplitude-versus-frequency plots may be required to determine the spectral 

characteristics of the air wave, ground roll, refractions, and reflections. 
 

Launch “WinVelp.exe”, choose Files… > Open from the main menu, select Dengland.dat, and input parameters, 

similar to the WinVelp Tutorial on page on page 48.  Choose Options > Spectrum Analysis from the main menu. 

For this example we will move to SSN 5 by clicking the “Next” button (Figure 28a). Click trace 18 and then click 

the “Spectrum” button to display the frequency vs amplitude spectrum of the selected data (Figure 28b). After the 

spectral information has been calculated, it will automatically be displayed on the screen—if system requirements 

are met. 

 

a)    b)  

Figure 28. Winvelp program displaying a) SSN# 5 seismic record after selecting “Options” and “Spectrum Analysis” 

from the main menu and b) frequency spectrum of trace 18. 

 

Visual options may be changed by clicking the Parameters menu of the “Velp Spectrum” window. For example, 

change the “End Frequency” from 1000 to 500, the “Color Value” from 0 to 3, and click the “Done” button (Figure 

29a) to see a modified “Velp Spectrum” window (Figure 29b). 

 

Choose File > Save Graph as File from the menu of the “Velp Spectrum” window to save the spectrum image as 

a .bmp or .wmf file. 

 

The Figure 30 images are examples of a good series of analysis runs necessary for helping decide on the appropriate 

digital filters. 
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a)    b)  

Figure 29. a) Changing values on the “Spectral Parameters” window and b) updated frequency spectrum of trace 18. 

 

a) 

    

b) 

 
 

c) 

    

d) 

 
 

e) 

    

f) 

 

Figure 30. Field-file 5 spectrum plots with a) whole trace spectrum and predominantly b) air-wave, c) ground-roll, 

d) refraction, and e) reflection energies compared to f) a possible bandpass filter. 
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Filtering 

Analysis of the spectral plots allows the designing of an appropriate digital filter to enhance reflection energy.  The 

most common type of digital filter and the most appropriate for our sample data set is a digital bandpass filter.  This 

filter by its nature will attenuate all energy with spectral values outside a defined window. The window is defined 

in the frequency domain and is shaped in accordance with predefined front and rear slopes. All of the filtering 

options available in WinSeis 1.8 have front and rear slopes that can be thought of in a very similar fashion as the 

taper previously discussed for the muting operation.  Without these slopes, when the transformation from the 

frequency domain to the time domain is made after filtering, sinusoidal artifacts will be injected into the seismic 

data.  The frequency of these artifacts will be related to the frequency of the defined high- and low-cut filter values 

of the bandpass. 

 

For the sample data set, it appears from spectral analysis that the dominant frequency of the reflection information 

is approximately 250 Hz.  The bandpass filter design must not attenuate any signal within one-half octave of that 

frequency.  The air-wave information ranges from about 50 to 400 Hz.  Of course, that frequency band is coincident 

with the reflection information. The muting operation performed early on in the processing flow removed the 

majority of the air-coupled waves.  The ground-roll frequencies, on the other hand, fall mainly within a band from 

about 25 to 250 Hz. With the amplitude of the high-frequency ground roll being small relative to the reflection 

information, the low-cut side of a bandpass filter should attenuate the majority of the ground roll.  The refraction 

energy is large amplitude and possesses about the same spectral characteristics as the reflection signal.  Once again, 

muting was essential, this time in removing the effects of the refracted energy. From the spectra of the various types 

of seismic energy arrivals, the optimum digital bandpass filter for the sample data set will be something in the range 

of 125 to 400 Hz. 

 

As with most seismic data processing, selecting a bandpass filter, whether from spectra plots or directly off raw 

field data, becomes easier with experience and a broader knowledge of the basic physical principles of seismic data 

processing.  There is also no substitute for a proper math and physics background.   

To build the batch processing file to operate on the seismic data from our sample data, the following sequence of 

parameters needs to be defined: 

 

Line Description 

 

1 >>START See previous description of >>START. 

 

2 *INPF NMOT.dat See previous description of *INPF. 

 

3 *F_FILT bp 80 125 400 500 

 

*F_FILT operation initiates the frequency-filtering operation.  The first input parameter (bp) designates a 

bandpass filter.  The second and third parameters (80,125) designate a low-cut (high pass) frequency.  The 

fourth and fifth parameters (400,500) designate a high-cut (low pass) frequency.  In our case, we are doing 

a band pass, but in certain instances the enhancement of reflection signal may involve the rejecting of a 

particular frequency window. For more information see WinSeis User’s Manual (i.e., page 5-20 of 

“8section5.pdf”). 

 

4 *OUTF FILT.dat See previous description of *OUTF. 

 

5 >>END See previous description of >>END. 

 

 Use the “winfilt.exe” GUI to use visual tools for entering filtering parameters (i.e., geometry). Each 

selection will be simultaneously written into the text file utility, “Cmdedit.exe”. See WinSeis User’s Manual 

(i.e., pages 1-23 and 1-25 of “4section1.pdf”). 
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As with all other batch processing files, double click on the SORT.dek file to launch “WSeis.exe” and run the .dek 

file. 

 

Again, the program will update its progress through the input data set.  As with previous operations, the list or 

journal file FILT.lst will still possess all the processing history as well as any errors or abnormal terminations.  

Once complete, the “WinView.exe” routine should be used to display at least a couple of files to ensure the results 

of the filtering operation were what was desired.  The cleaning up of the data after filtering should be quite evident 

(Figure 31). 

 

a)  b)  

Figure 31. Field-file 5 a) before and b) after filtering. 

 

The bandpass filtering of our sample data set not only improved the signal-to-noise ratio, it also removed DC bias 

present on the raw field data.  DC bias is related to wander in the analog side of the seismograph and appears on 

raw field data as over- or undershading of the variable area wiggle-trace.  The removal of DC bias is critical to the 

effective stacking of seismic data.  Comparing the images before and after filtering (Figure 31), it is possible to 

identify the DC bias.  The amplitudes of the reflection wavelets have much more trace-to-trace consistency after 

the filtering operation.  The low-cut filter is actually responsible for the removal of the DC bias. 
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AMPLITUDE BALANCING 

The relative amplitude of each sample recorded on a seismic trace is dependent on several properties and parameters.  

The properties that dictate amplitude response are related to the earth and the propagation of acoustic waves 

through the earth. The parameters that influence the amplitude of any one sample are related to acquisition 

equipment and the settings of that equipment.  Therefore, to generate a CDP stacked section with relatively equal 

contributions from all traces summed within a particular gather, some trace-equalization is necessary.  It should be 

noted at this point that for some analysis techniques (AVO, amplitude vs. offset, for example) retaining absolute 

amplitude with increased offset is critical. Correction for spherical divergence is necessary, but global trace 

equalization as is suggested for our sample data set would be detrimental to meaningful conclusions. 

Automatic Gain Control (scale) 

An Automatic Gain Control (AGC) should next be applied to the sample data to boost the amplitudes of the 

reflection information relative to the higher amplitude, ground roll, air-wave, and refraction energy.  The purpose 

of this scaling operation is to maximize the potential of the stacking process to enhance the reflection information.  

This can be clearly visualized by plotting the raw data without any normalization or scaling.  Display with no 

normalization or scaling is called plotting relative.  This means that true amplitude information is preserved and 

present on the plot.  By modifying “Trace Gain dB” value of “Winview.exe” “View Select” window options 

(shown in Figure 3), the user can boost the display gain uniformly for the entire data set until it is up to a desirable 

level.  Now observe the amplitude of the reflection event at 75 ms on all 24 traces (Figure 31).  It is quite clear that 

if all 24 traces were added together and their amplitudes divided by 24, a disproportional amount of the final stacked 

data is from the contribution of the few traces on the inside with significant amounts of high-amplitude ground roll 

and air-coupled waves. The best way to correct for this inequality is by applying a time-varying trace-by-trace 

gaining function.  In the WinSeis package, this operation is called *SCAL (meaning scale). 

 

Selection of the appropriate AGC window is at least partially qualitative, requiring experience and a thorough 

understanding of the mathematics of the operation.  Assigning the AGC window to be about twice the repetition 

time of identifiable reflecting events is a rule of thumb that we have found to be generally effective. 

 

In the case of the sample data set, the strong reflecting events at approximately 75, 100, 120, and 150 ms seem to 

have a repetition time of around 25 to 30 ms.  This suggests that, in order for the AGC window to detect the presence 

of at least three of the reflecting events within a single window, the window size should be somewhere around 

50 ms.  So, 50 ms will be used for a first-pass trial scaling window.  Basically, the scale window must be small 

enough that subtle reflecting events do not get overpowered by the more high-amplitude events, yet large enough 

that localized comparisons of relative amplitude between reflecting events at various times can be made.  Final 

interpretation of the stacked data must be made with the AGC processing parameters taken into consideration. 

 

A couple of warnings: 

1) An inappropriate AGC window can generate artifacts on stacked seismic data.  Most notable are the effects of 

a window that is around twice as long as the time difference between the high-amplitude first-arrival and ground 

roll or air-wave information.  Due to this longer window, the contribution of the lower-amplitude energy located 

between the first arrival and ground roll or air wave is insignificant in comparison to the effects of the first 

arrival and ground roll or air wave. The resulting stacked data could possess a high-amplitude band of informa-

tion with spotty coherency that is nothing more than stacked ground roll or air wave. 

2) An AGC is most effective when the amplitude of noise is high on a few traces relative to signal at an equivalent 

time on other traces.  In such a case, not using the AGC on unstacked data could result in data with a significantly 

lower signal-to-noise ratio than is truly representative of the data. 

 

For our sample data set, the following batch processing file will most effectively boost the signal-to-noise ratio, 

retain some relative amplitude information, and improve the interpretability of some of the subtle reflecting events 

identifiable on the field files. 
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Line Description 

 

1 >>START See previous description of >>START. 

 

2 *INPF FILT.dat See previous description of *INPF. 

 

3 *SCAL 50 

 

The *SCAL identifier initiates the scaling operation within SEIS. The first entry (50) determines the 

window length of the scaling operation. This value is in milliseconds (ms). There are other entries 

associated with the scaling operation (see page 5-29 of WinSeis User’s Manual “8section5.pdf” file), but 

for the data set we are processing here the default values are adequate.  One of the other potential variable 

parameters allows the user to choose either absolute value mean or root mean square, with a user-

definable reference mean.  The particular type of statistical technique used to determine the amount of gain 

necessary for each sample results in subtle differences on most data sets. A discussion of which type is best 

and for which type of data is not appropriate for this manual. The reference mean is a value set for 16-bit 

data and variation of this value will affect the amount of gaining necessary relative to maximum possible 

deflection. A third parameter relates to delay time in the initiation of the scaling operation. 

 

4 *OUTF SCAL.dat See previous description of *OUTF. 

 

5 >>END See previous description of >>END. 

 

As before, the batch processing file just created to automatically gain individual samples relative to nearby samples 

on the same trace within the defined window will operate on the previously filtered data by double clicking on the 

SCAL.dek file to launch “WSeis.exe” and run the .dek file. 

 

The effects of the scaling operation are most likely not worth plotting the entire data set to see.  The “WinView.exe” 

display routine will give a sufficient look at the data to determine if the window is correct and if the operation was 

complete and correct.  The effect of the scaling is actually quite evident on our sample field file (Figure 32). 
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a)     b)  

Figure 32. Field-file 5 a) before and b) after AGC. 
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STACK 

The CDP stacking or summing process is the culmination of most modern digital seismic data processing.  CDP-

stacked multi-fold seismic data are generally the most useful and most common final form of seismic reflection 

data. A properly processed stacked section can be used to interpret a significant amount of geologic information.  

The stacking process, if all previous processing operations and parameters have been appropriate and in a logical 

sequence, will enhance seismic-reflection information. The processing flow prior to stacking is solely intended to 

manipulate and prepare reflection information to be added constructively, while all other energy (noise) adds 

destructively. 

 

The CDP stacking of reflection data amounts to the summing all traces with the same midpoint between source and 

receiver (after correcting for different source-to-receiver distances), and dividing by the number of traces summed 

(or some other logical dividing screen).  This process is conceptually quite simple. 

 

Line Description 

 

1 >>START See previous description of >>START. 

 

2 *INPF SCAL.dat See previous description of *INPF. 

 

3 *STAK 1 

 

The *STAK operator initiates the CDP stacking process.  The first entry (1) identifies the divisor after the 

summation process necessary to return the amplitude levels to near pre-stack values. The divisor can be 

selected as the actual number of input traces (fold) or the square root of the fold. The square root option 

will simply result in an increase in the relative significance (from an amplitude perspective) of higher fold 

gathers. 

 

4 *OUTF STAK.dat See previous description of *OUTF. 

 

5 >>END See previous description of >>END. 

 

 

The CDP stacking file operates on the scaled data by double clicking on the STAK.dek file to launch “WSeis.exe” 

and run the .dek file. 

 

Viewing/Plotting the output is a must (especially since this is the conclusion of this basic processing flow). The 

plotting parameters used on stacked data are very dependent on interpretation preference. The larger the number of 

traces per inch the more apparent coherency is on the stacked section. In addition, the larger the number of seconds 

per inch, the harder it is to detect small variations in depth as well as a decrease in apparent resolution.  It is good 

to experiment with the plotting parameters on the finished stacked section until the image is appropriate for the 

needs of the user. 

 

The final stacked data set plotted should be quite similar to the one displayed in Figure 33. 
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Figure 33. Final CDP stacked section. 

 

Simply to show the true power of WinSeis 1.8 and the batch-processing mode operation, the following batch 

processing file could have been set up for the sample data set at the very beginning and executed.  The input to this 

batch job is the raw formatted data and the output is a stacked section all in one deck. The appropriate sequence 

would look like this: 

 

>>start 

*inpf dengland.dat 

*edkl 92 8 

kill 1 1 12 12 

kill 2 2 11 11 

kill 3 3 10 10 

kill 4 4 9 9 24 24 

kill 5 5 8 8 23 23 

kill 6 6 7 7 22 22 

kill 7 7 6 6 21 21 

kill 8 8 5 5 20 20 

kill 9 9 4 4 19 19 

kill 10 10 3 3 18 18 

kill 11 11 2 2 17 17 
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kill 12 12 1 1 16 16 

kill 13 13  15 15 

kill 14 14  14 14 

kill 15 15 13 13 

kill 16 16 12 12 

kill 17 17 11 11 

kill 18 18 10 10 

kill 19 19 9 9 

kill 20 20 9 9 

*edfm 92 8 

tapr 10 

farm 5 1 30 24 65 

*edmt 92 8 

tapr 10 

mute 5 1 57 70 24 222 237 

*sort 12 19 

ptrn 2.5 24 1 

pn 1 108 115 24 1 

shot 

sn 1 108 1 0 0 1 

snsn < 2 19 1 > < 109 126 1 > 1 

sn 20 127 1 0 0 1 1 24 

tabl 1 1 

*surf 100 

alvf 105 770 90 

se 126 99 100 

se 127 100 

se 136 100 

se 137 103 100.3 

se 138 106 100.6 

se 139 100 

se 140 99 

se 141 99.6 

se 142 100.6 

se 143 100 

*nmot 0.6 0 0 1 

velf 230 45 1850 60 2600 90 2600 110 2900 135 3000 

velf 235 45 1850 60 2450 90 2450 110 2900 135 3000 

velf 250 45 1850 60 2300 90 2300 110 2900 135 3000 

velf 255 45 1850 60 1900 110 1900 150 2250 

velf 275 45 1850 60 1900 110 1900 150 2250 

velf 280 45 1850 60 2450 90 2450 110 2900 

*f_filt bp 80 125 400 500  

*scal 50 

*stak 1 

*outf stak.dat 

>>end 

 

This batch file is included with the demo and can be run by double clicking on the PROCESS.dek file to launch 

“WSeis.exe” and run the .dek file. 
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FURTHER PROCESSING/ADVANCED TECHNIQUES 

Other operations available in WinSeis 1.8 include deconvolution, surface-consistent statics, residual statics, f-k 

migration, and f-k filter. 
 

In summary, a wide variety of processing-flow options is available with WinSeis 1.8 after the data have been sorted.  

Inexperienced analysts are encouraged to refer to books on seismic-data processing and to experiment with the 

program prior to processing data that are critical to a specific project.  The technical user’s manual will provide the 

necessary mechanical guidance to work through the many program options. It is not appropriate, however, to use 

the program without some knowledge of why various processes are used. 

  

SUGGESTED READING 

There is abundant literature on seismic reflection data processing (Mayne, 1962; Robinson and Treitel, 1980; 
Waters, 1987; Whiteley et al., 1998; Yilmaz, 2001). 
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